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Introduction

Frontier is a browser-based application that is the next generation of Equity. It ensures system stability and
allows for new features to be built in. This Reference Guide covers an overview of the browser-based
application, logging on andaccessing instructions and enhancements to the Toolbar Settings, Customization,
Print Output Queue, Job Management, Security and Late Deal Claim.

Logging On

The following section outlines how to access Frontier from a Desktop, RF Gun and Employee Facing Device
(EFD), signon, add the URL as a desktop icon and get remote access.

Remote access includes accessing Frontier from outside your store.

Open an Internet Browser. Use either IE (10 or higher), Chrome (version 56 or higher), Safari (12 or higher)
or Edge (83 or higher).

» Type the URL to access the Frontier application: https://XXXX-frontier.ctr.cantire.com/ (where XXXX is
your 4digit store number).
» Press Enter.

The Frontier Sign On screen displays:

Note: This may vary depending on OS or browser used. If the user needs specific workstation names, the
recommendation is to create multiple shortcuts where each has a variation of the workstation name — for
multiple user sessions.

From a Desktop Computer:

» Right click on the Desktop.

1| June 2021
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A drop down menu displays:

View 4
Sort by 4
Refresh

Paste
Paste shortcut
Undo Move Ctrl+Z

& Intel® Graphics Settings
New »

Screen resolution

Personalize

nom

» Click on New from the drop down menu.

A sub-menu displays:

| k. Folder
|L| Shortcut

AL Microsoft Access Database

& Bitmap image
|#=| Contact
Wi Microsoft Word Document
2] Microsoft Project Document
2] Microsoft PowerPoint Presentation
& Microsoft Publisher Document

Text Document

=] Microsoft Excel Worksheet

f Compressed (zipped) Folder
ﬁ Briefcase

» Click on Shortcut from the sub-menu.

The Create Shortcut window displays:

x|
&) - Create Shortcut

What item would you like to create a shortcut for?
This wizard helps you to create shortcuts to local or network programs, files, folders,
computers, or Internet addresses.
Type the location of the item:
Browse...
Click Next to continue,
iext | [ cancel |

» Type the URL in the Type the location of the item field.
» Click on the Next button.
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The What would you like to name the shortcut? prompt displays:

@ » Create Shortcut
= g = .

What would you like to name the shortcut?

Type a name for this shortcut:

New Internet Shortcut

Click Finish to create the shortcut.

F=

» Type Frontier in the Type a name for this shortcut field.
» Click on the Finish button.

The Frontier shortcut displays on the desktop.

The Sign on screen looks slightly different (unused fields have been removed) however signing on to the system
remains the same.

Note: Users must first be set up in the CT Identity (CTID).

From the Frontier Sign On screen:

Click in the User/Utilisateur field.
Type your Username.

Click in the Password/Mot de passe field.
Type your Password.

v Vv Vv Vv Vv

Press the Enter key.
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Generic users (such as Inquiry users) will continue to use the same log on they used in the previous system.

Note: Username format in Frontier is: 0123.johnsmith. The Store number is pre-populated for you.

Important: Passwords are case sensitive. After five attempts, you are locked out of your account. To unlock your
account, contact your CTID System Administrator.

The Frontier Master Menu displays:

CANADIAN TIRE
MASTER MENU

Recommended Operating Procedure: You must wait until the Master Menu displays before typing.
Any commands typed before the Master Menu displays are not logged into Frontier.
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Toolbar Settings and Customization

From the Master Menu screen:

QPADEV@0O7 CANADIAN TIRE

GMNROO1 M ASTEHR M ENU

» Click on the arrow - icon.
The toolbar displays:

0 o
QPADEVee@7 CANADIAN TIRE
M ASTEHR MENWU

» Click on the desired icon to perform an action

» Click on the arrow Il icon to close the toolbar.

You can hover your mouse over the icon to get a You can copy/paste using keyboard shortcuts:

description.

Highlight the desired text using the

m] Copy selected text. cursor.
Press the Ctrl + C keys to copy text.

Press the Ctrl + V keys to paste text.

Paste Next.
Change settings such as display, picture, colour, etc.
Work with macros (create or delete or run).

Customize keyboard mapping.

File upload.

B OAEGE

Display Pop-up Keypad.

Note: Changes that are made to settings, macros and keyboard maps are saved under the User Profile in use and are in
effect on any computer signed on to Frontier under that profile. The settings associated with your User Profile are in
effect after signing on.
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The Settings K icon on the toolbar allows the user to change the appearance of certain elements in Frontier
such as cursor shape and font colour, displaying rulers on screens and customizing sounds. Any changes made to
the settings,macros and keyboard maps are saved under the user profile and are in effect on any computer
signed in under that profile. The settings are in effect after signing on.

You can access the Settings Window from any screen in Frontier by clicking on Settings B icon in the toolbar:

Settings
Shape:
Rule Line @ Underline
O Block
Viewing
Blink:
Product Pictures / O Yes
Webshop ® No
Pictures Screens Shape Change in Insert:
Colour Mapping @ Yes
O Neo

Sound
Popup Keypads
Impaert Settings

Export Settings

Defaults m
- [
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You can customize the cursor to display a different shape, turn blinking on or off and change the shape in Insert
mode.Follow these steps to change the cursor settings:

From the Settings window:

Settings

Rule Line @ Underline

© Block
Viewing

Blink:

Product Pictures / O Yes
Webshop © o
Pictures Screens Shape Change in Insert:
Colour Mapping ® Yes

QO No

Sound
Popup Keypads

Import Setiings

Export Settings
Defaults m
- B

» Click on Cursor from the list.

The Cursor window displays:

Settings
Shape:
Rule Line @ Underline
O Block
Viewing
Blink:
Product Pictures / O Yes
Webshop © o
Pictures Screens Shape Change in Insert:
Colour Mapping @® Yes
O No

Sound
Popup Keypads
Import Settings

Export Settings

™ ..

» Click on the radio button to select your options.
» Click on the Save button to save the settings.
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The following chart outlines the cursor options:

» Yes (The cursor changes shape

» Underline _ » On (Displays a e 0
I blinking cursor) when the keyboard is in insert
> B
lock » Off (Displays a mode).

Note: The keyboard goes into insert mode
when you press the insert key on the
keyboard. INS displays at the bottom of the
screen and the cursor changes to ahalf block
M icon.

non-blinking
cursor)

» No (The cursor does not change
shape whenthe keyboard is in insert
mode).

The default setting in Frontier is to display the cursor position at the bottom right corner of the screen. This is
expressed as a row/column number. Imagine the screen as a grid; each space on the screen is a cell in that
grid. This determines the row and column number. For example, if 02/02 displays, it means the cursor is in
row 2, column 2. The cursor position is handy ifyou are having trouble seeing the cursor on the screen. Follow
these steps to display and hide the cursor position:

From the screen you are working on:

» Click on the Settings E icon on the toolbar.

From the Settings window.

» Click on Viewing from the list.
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The Viewing window displays:

Settings

Row/Column Indicator on OIA:

No

» Click on the radio button beside On or Off under Row/Column Indicator on OIA depending on whether you
wantto display the cursor position or not.
» Click on the Save button to save the settings.

The ruler is a line that you can display on the screen that follows the cursor. Under Rule Line you can choose a
verticalruler, horizontal ruler, or both (crosshair). By default, the ruler does not display.
Follow these steps to adjust the Ruler settings:

From the Settings window:
» Click on Rule Line from the list.

The Rule Line window displays:

Settings

Cursor Rule Line:

QO On

® off
Viewing

Rule Line Style:
Product Pictures / © Horizontal
Webshop O Vertical
i ® Crosshair
Pictures Screens
Colour Mapping
Sound
Popup Keypads
Import Settings
Export Settings
& -

» Click on the radio button to select your options.
» Click on the Save button to save the settings.

9 | June 2021



FRONTIER COMPUTER OPERATOR QUICK REFERENCE

There are three ruler options:

Horizontal

Inventory Manager Inquiry

) . AIRGRP FRY

Inventory Manager Inquiry
32CM TFAL A A
42-0209

Inventory Manager Inquiry

TFAL AIRGRP FRY St Can order

42-0209

le story F8=Location Details

related prid F11=Display open orders
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Product pictures can be added to screens that display product information such as the Inquiry or Analyze
screens.The product pictures display automatically unless the settings are adjusted. Follow these steps to add
or remove product pictures:

To adjust product pictures:

From the Settings window:
» Click on Product Pictures from the list.

The Product Pictures window displays:

Settings

Cursor Show pictures

Rule Line @® Overlay mode O Pop-up mode

Viewing Opacity:
Size: © Small O Medium @ Large
Product Pictures /
Webshop

Location: @]

Pictures Screens

o y _\ ®
Colour Mapping
Timeout:
Sound
Webshop Popup

Popup Keypads Size: © Small O Medium @ Large
Import Settings

Export Settings

E Close

Click in the Show Pictures checkbox to select your options.
Click on the radio button to select your preferred options.
Click on the Save button to save the settings.

Click on Pictures’ Screens from the list on the Settings window.

v Vv v Vv
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Product pictures automatically display on the following screens:

Inventory Manager Inquiry

Floor Inquiry

Analyze Suggested Regular Orders
Analyze Promo Stock Levels
Analyze Suggested Seasonal Orders
Analyze Suggested Placing Orders
Analyze Quantity On Hand

Store Analysis Maintenance
Analyze Product Strategy

vV Vv VvV VvV VvV VvV VvV v v . v

RF Receiving

The Pictures’ Screens window displays:

Settings
Cursor EQZUDIR Inventory Manager Inquiry
v "
fule Line [ EQLKD1R Floor Inquiry
ESCXD1R Analyze Suggested Regular Orders
Viewing ESJSDFR Analyze Promo Stock Levels
Product Pictures / ERXDDFR Analyze Suggested Seasonal Orders
Webshop EQRIDFR Analyze Suggested Placing Orders
EQUGETR Adiust Quantity On Hand
Y326R021 Store Analysis Maintenance
Colour Mapping
ETUTDFR Analyze Product Strategy (AIM)
Sound INVRO64 RF Receiving
Popup Keypads
Import Settings
Export Settings
B3| o

» Click the checkboxes beside the screen name to uncheck any screens that you do not want to display product
pictures.
OR

» Click the checkboxes to check any screens that you do want to display product pictures.
» Click on the Save button to save the settings.

Note: If the product picture is unavailable for a specific product, a message Image not available displays.

Note: Changes to all settings (not just picture settings) are saved with the user profile and are in effect on any computer
where that user signs on. Clearing the browser history has no effect on a user’s settings.
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Picture Display Options

Show Pictures » Click the Show Pictures checkbox to display a picture of the
product on screens that display product information. Uncheck
the checkbox if you do not want product pictures to display.

Overlay Mode » Click on the radio button beside Overlay mode to display
product pictures as part of the screen. The product picture
automatically changes when a new product displays:

961

HOM ST

:
1.00
3.6
238.9
41420
414XX

Pop-up Mode » Click on the radio button beside Pop-up mode to display a product
picture in a separate window:

961
e r .

® q91caj00007frnt:8080/pic.htmI?id=0420204

Note: You can move the picture anywhere on the screen. The picture in
the window does not change when you display a new product.

Opacity » Click and drag the Opacity slider to choose the transparency of the
product picture. The very left is the most transparent and the very
right is opaque (least transparent).

Minimum Opacity Maximum Opacity
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Size » Click on the radio button beside Small, Medium or Large to select
the picture size.

Location » Click on the radio button that corresponds with the area of the
screen you want the product picture to display; top left corner, top
right corner, bottom left corner or bottom right corner.

Note: Once the picture displays, you can click and drag it to a different
spot on the screen.

Timeout » Click and drag the Timeout slider to choose how long the picture
displays before disappearing. If the slider is to the very left, the
picture displays permanently. If the slider is to the very right, the
picture no longer displays after 15 seconds.
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The text and screen colours can be customized in Frontier. Follow these steps to change the text and screen
colours.

From the Settings window:

» Click on Colour Mapping from the list.

The Colour Mapping window displays:

Settings

£ =
3
4

Sample text

Mhite:
Colour Mapping
Sound

Sample text

neoooens

» Click on the drop down to select your colours for the text.
Note: This option allows you to swap the text colours
» Click on the Screen drop down to select a screen colour.

» Click on the Save button to save the settings.

Note: Changes to all settings (not just colour settings) are saved with the user profile and are in effect on any
computer where that user signs on. Clearing the browser history has no effect on a user’s settings.
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System sound settings can be customized in Frontier. Follow these steps to change the sound settings:

From the Settings window:

» Click on Sound from the list.

The Sound window displays:

Settings

@ o

Clicker:

oo RS

Click on the radio button(s) to select your preferred options.

Click on the Clicker and Alarm drop down menus to see the sound options.
Click on the Play button to hear the sounds.

Click on the Save button to save the settings.

v Vv Vv Vv

The following chart outlines the system sound options:

e

» On: Does not play » Normal: Plays the clicker » On: Plays the beep wherever a
anysystem sounds. sound every time a validkey program specifiesthat there should
is pressed on the keyboard. be a beep.

» Off: Plays sounds for
alldefined system
events.

» Error: Plays the error
sound if an invalid key is
pressed.

» Off: Does not play any
sound when a valid or
invalid key is pressed.

» Off: Does not play the beep
where a programspecifies there
should be a beep.
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A pop-up keypad is a small window with buttons that allow you to perform certain actions. For example, if
you are working on a laptop where the keyboard does not have a Field+ key, you can still press Field+ by
displaying the pop-up keypad and clicking the Field+ button in the keypad window.

Note: To display the pop-up keypad, right click on any screen in Frontier or click on the Pop-up KeypadE icon on the
Frontier toolbar. You can move the keypad anywhere by clicking and dragging it to another part of the screen. Depending
on your settings,the keypad may close automatically when clicking a button on the keypad. If “sticky popup keypad” is On,
click the X to close it. If “stick popup keypad” is Off, click a button or press any key to close it.

Follow these steps to change the pop-up keypad settings:
From the Settings window:

» Click on Popup Keypads from the list.

The Popup Keypads window displays:

Settings

Cursor Current keypad: Sticky Popup Keypad: Pads:
Rows O on
Columns: [2+. ® Off

Select action: Type Macros « ] Name ‘ test «

Rule Line
Viewing

Product Pictures /
Webshop

Page Up Enter
Pictures Screens Page Down Field+

Colour Mapping Attention Field-

® Pad1 O Pad2
Sound

Popup Keypads

Import Settings

Export Settings

Defaults

» Click on the drop down menus and/or radio buttons to select the desired options.
» Click on the Save button to save your settings.
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The following chart outlines the pop-up keypad settings:

Change the layout and behaviour of the keypad:

Current Keypad » Rows: Select how manyrows of buttons you want in the pop-up
keypad.
Columns: Select how many columns of buttonsyou want in the
pop-up keypad.

Sticky Pop-up Keypad » On: The pop-up keypaddisplays until manually closed.
Off: The pop-up keypadautomatically closes when you click on
a button on the keypad.

Pads » The total number of pop-up keypads that you want to have.
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Change the buttons in the keypad:

Type » Macros: Executes the macros selected under theName field.
» Functions: Executes the functions under theName field.

Name » Choose the macros or function that you want toexecute:
o Ifyou select Macros in the Type drop down,the Name drop
down displays the macros that you can assign.
» If you select Functions in the Type drop down, the Name drop down
displays the functions thatyou can assign.
» Click on the button you want to assign the actionto:
o If you click on a button that has an action already assigned,
the existing action is replaced by the one you selected and the
name on the button changes accordingly. If you click on a
blank button, the action isassigned, and the name displays on
the
button.

Pads » The total number of pop-up keypads thatyou want to have.
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The copy/paste functions allow you to copy and paste information from Frontier to another program and copy
numbersfrom a list and paste them into other screens in Frontier.

Follow the steps below if you need to remember a number on a screen to type on another screen such as an
invoicenumber.

From the screen you are working on:

EQUSDFR Work with Invoices

only inv e #

ition to facility . . . .

=Delete invoic 5=W.w. i e cke i 6=Print invoice

8=Print tick 0 o ve ory o S analysis

Invoice Warehouse/ Invoice
Invoice# Date B.O.L.# Depot Status Facility
1730544 16/10/25 000000004116639 9 On truck 970
1730545 16/10/25 000000004117385 On truck 970
1734318 16/10/26 000000004119090 On truck 970
1737764 16/10/27 000000004121346 On truck 970
1737766 16/10/27 000000004121348 On truck 970
1737769 16/10/27 000000004121351 On truck 970

16/10/28 000000003496912 On truck 970
1738734 16/10/28 000000004110841 On truck 970
1741609 16/10/28 000000004123744 On truck 970
1741610 16/10/28 000000004123745 On truck 970

F3=Exit F6=Add invoice F8=Ww. stock movement F12=Previous

» Click and drag the cursor around the number that you want to copy.

» Press the Ctrl + C keys simultaneously to copy the number.
OR
» Click on the Copy icon on the toolbar.

From the screen that you want to paste the number in:

» Click the field where you want to paste the number.
» Press the Ctrl + V keys simultaneously to paste the number.
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Follow these steps to copy and paste selected text or a screen from Frontier and paste it elsewhere such as an
email ordocument, or even another screen within Frontier.

From the screen you want to copy text:

Floor Inquiry 3/29/17 9:02:57 Str
6 32Cm Tfal Airgrip Frypan
A Can order Str 8/07/15 rc 14/02/18

Regular :

Surchr

(]

17/02/19 S 17/02/02
0/00/00 d: 17/02/09
0/00/00 s

17/03/23
HOM ST
16/12/15

[

] xit F7=Lost sales F8=Location Details F9=Promo information
F10=Subs/related prd F11=Display open orders F12=Previous F24=More keys

21/40

» Click and drag the cursor around the text that you want to copy. You can also select the entire screen area.

» Press and hold down the Shift key.

» Press the arrow key that corresponds to the direction you want to select text. The selection box
expands in thedirection of the arrow key you press.

» Press the Shift key and the arrow key that corresponds to the direction you want increase the
size of theselection area simultaneously.

To change your selection:
» Click anywhere outside the selected area to make the highlighting disappear so you can start over.

OR

» Hover the cursor anywhere at any edge or corner of the selected area to display a double arrow icon
or in themiddle of the selected area to display a cross arrow icon.

» Drag the arrow with your mouse or press the Shift key and the arrow key that corresponds to the
direction youwant to move the selection.
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A white box displays around the selected text:

EQLKD1R Floor Inquiry
43-2119 6 KA GOURMET ATT PACK
Str/CTC: A Can order Str/ c
Pric On hand/on or
Regular :
Promo : e : e
Surchrg : .00 Total O : WTD

Shrink H PTD

Hold ¢

17/09/0
Env fee :
PST/GST : N / Y : s al: 143
Rain che : Y : ] Q : ]
d prd--- Ls : 17/10/20 ea r: 17/10/20 ack:
RelPrd: 43-2170 : e/00/00 DealEnd: 17/11/09 Std pack:
: : e/e0/00 Bonus

Nxt e : 17/11/23  -------------- Comments

F/C : HOM ST

Lst rc : 17/10/10

Rcd y 4

Inv sts :

xit F7=Lost sales F8=Location Details F9=Promo information

F10=Subs/related prd F11=Display open orders F12=Previous F24=More keys

» Press the Ctrl + C keys simultaneously.
» Click on the Copy icon on the toolbar.

From the program you want to paste the information in:
» Click on the screen in the area you want to paste the information.

» Press on the Ctrl + V keys simultaneously.
OR

» Click on the Paste button in the program you are using.

Note: The appearance of the Paste button varies depending on the program you are using.
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The text displays in the selected program:

EQLKDIR Floor Inquiry 12/22/17 13:08:24 Str: 970
43-2119 6 KA GOURMET ATT PACK
Str/CTC: A / ACan order Str/Dsc 6/05/26Dsp: 02 Prcchg: 16/01/11

Price----------—-— Onhand/on order--  Sales--—----—---- Location----------
Regular: 22999 RetailOH: 5§ Today 0 Retail - 070L02
Promo : 179.99 Whse OH: 0 Reserve: 0 - WU108D
Surchrg: 00 TotalOH: 5 WID 0 :

Shrink : 5 PTD : 0 Whse -

Hold code: YD - 5 BinRet: 4 0

Reg OOC: 0 LstSale: 17/09/06 Order point/pack--
Env fee: .00 Promo OO: 0 Promo-----—------- MinQP - 0

PST/GST:N /Y Pla OO: 0 LstDeal: 143 Ord pt: 1

Raincheck : YS/O QO: 0 QiySold: 0 Stkivl: 2

Sub/related prd--- Lstord: 17/10/20 DealStr: 17/10/20 Min pack: 2

RelPrd: 43-2170 Strdue : 0/00/00 DealEnd: 17/11/09 Sidpack: 72
ETA  : 0/00/00 Bonus :

: NxtADte - 17/11/23 --- Comments
Auto - F/C :HOM ST
Sugg - Lstred: 17/10/10
Store - Red gty - 4
Recode: Invv sts :

F3=Exit F/=Llostsales F8=LocationDetails F?=Promeo information
F10=Subs/related prd F11=Display openorders F12=Previous F24=More keys

Note: When pasting, the font does not line up the way it does on the Frontier screen. To adjust this, change the font to
LucidaConsole or Courier New. You can also remove the space between lines and reduce the font size.

EQLKD1R Floor Inquiry 12/22/17 13:08:24 sStr: 970
43-2119 6 KA GOURMET ATT PACK
Str/CTC: A / A Can order str/Dsc: 6/05/26 Dsp: 02 Prc chg : 16/01/11
Price---------—--——- on hand/on order-- Sales—-—-----—--——- Location----------
Regular : 229.99 RetailOH : 5 Today 0 Retail : 070L02
Promo : 179.99 whse OH : 0 Reserve: 0 : WU108D
surchrg : .00 Total OH : 5 WTD : 0 :
shrink 5 PTD 0 Wwhse :
Hold code: YTD : 5 BinRet: 4 0
Reg 00: 0 Lstsale: 17/09/06 Order point/pack--
Env fee : .00 Promo 00: 0 Promo------------ Min OP : 0
PST/GST : N/ ¥ Pla 00: 0 LstDeal: 143 ord pt : 1
Rain check Y S5/0 00: 0 QtySold: 0 Stk Ivl : 2
sub/related prd--- Lst ord : 17/10/20 Dealstr: 17/10/20 Min pack: 2
RelPrd: 43-2170 str due : 0/00/00 DealEnd: 17/11/09 sStd pack: 72
: ETA - 0/00/00 Bonus :
: NxtADte : 17/11/23 -————--————————- Ccomments----—————---————
Auto F/C : HOM ST
sugg Lst rcd @ 17/10/10
Store : Rcd gty : 4
Recode: Inv sts :
F3=EXit F7=Lost sales F8=Location Details F9=Promo intormation
F10=Subs/related prd Fll=Display open orders F12=Previous F24=More keys
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Follow these steps if you are working with many items in a list and you want to type the same option number
besideother items:

From the screen with the list you want to adjust:

ETUHEFR Work with User-created Reference Fields

)sition to Reference Field

Reference

Field Description
$39.99 $39.99
016 016
0800613 0800613
111188 111188
11211S8S 1121188
1121ISS 112188
11401ISS 11401SS
1151S8S 1151ISS
1171SS 117188
1200690 1200690
1241SS 1241SS
1251ISS 1251ISS

F3=Exit F6=Add F12=Previous

» Type the option number beside each item in the list.
» Select the numbers.

» Press the Ctrl + C keys simultaneously.

» Press the Page Down key.

» Insert the cursor in the first Opt field.

» Press the Ctrl + V keys simultaneously.

The numbers are pasted in the Opt fields.
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Follow these steps to copy information from an Excel spreadsheet into the Store Analysis - Enter Keys screen in
Frontier.

From the Excel Spreadsheet:

T —— . DWO_Inactive List 02-03-2017s-
Inset  Pagelmout  Formular  Data  Rewew  View  Developer  Adddns  Acobst  Checkist
ariat C10 - AN =l 9 Fwepted Text

S A EER EE EMegeaceter S % v WA o

Font goment _ 3 o
| (1) Security Waming  Macros have been disabled. | Enabie Content
A6 - £ | 0072180

007 0072238 0072244 0072248
0088405 0088598 0089107 0089304
0089690

il
0211012
0398584

DaRTI4>

» Use the cursor to select all columns of numbers.

» Press the Ctrl + C keys simultaneously.
OR

» Click on the Copy button on the Excel ribbon.

From the Frontier Master Menu:

» Type menu options 22/01/01.
» Press the Enter key after typing each option.
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The Store Analysis - Enter Keys screen displays:

STORE ANALYSIS - ENTER KEYS

Product Product Product Product Product Praduct
[ 3 o

» Press the Ctrl + V keys simultaneously.

The fields populate with the pasted information:

Y326R035 STORE ANALYSIS - ENTER : 3/06/17
TEST : 08:24:06

Product Product Product Product Product Product Product Product
0041732 3 0051841 0051854 8051919 851940 0051949 0051967
Qe 3 0052046 0 9052330 0052332 0053049 9053949
e 0062042 0062044 0062049 0062051 0062056
0062144 0062221 0062222 0062245 00623380

0063049 0071515 ee72019 0072063 2072065

08721480 0872151 0072236 0072244 0072248 0072354

0088400 0088401 0088402 0088598 0089107 8 00893065
0 0089385 0089389 @ 0089679 0089687
0089852 0089875 6089890 0089915 0089931
©211005 0211006 0211009 82110180 8211011 211012 0220219 0 0220408
0228086 0340746 0354535 0398542 0398569 0398584 0398587 0430053 0436999

0438973 0438974 0452111 0460105 0461030 0462467 0462468 0462469
0462495 0462503 0462507 0462508 0462514

0462856 0462864 0462903 0462909 0462911 0462912

0462923 0462929 09462930 0462935 0462937 0462951

0462963 0462964 0462969 0462971 0462973 0462974

ENTER=Continue

Important: If you copy more than 16 rows of numbers, only the first 16 rows from the Excel spreadsheet are
pasted. If there are more copied product numbers to be pasted, press the Page Down key to display the next
page of input fields. Press the Ctrl + D keys simultaneously or click on the Paste Next [ icon in the toolbar.
Repeat the steps until allnumbers are pasted. If the sound settings are set to play system sounds, the system
notifies via a Paste Incomplete sound if all the copied content cannot be pasted in the input field and notifies via
a Paste Complete sound once all numbers are pasted.
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Keyboard Shortcuts

A keyboard shortcut allows certain keys or a combination of keys to execute a selected function: For example,
you can set up the Ctrl+G keys to execute a macro.

Default Keyboard Shortcuts: Use the Ctrl + C keys to copy selected text to the clip board. Override a default
shortcut with another function if you wish. If you select a key or combination of keys that already have an
assigned shortcut, a message displays to tell you what is currently assigned. If you have overridden a default
shortcut, you can always turn itback on. Click ON beside the default shortcut. This puts the default back into
effect and deletes the custom shortcut that you created to override the default shortcut.

Once keyboard shortcuts are mapped, they are saved to your user profile and are available on any computer
you log onto.

Follow the steps to create a custom keyboard shortcut:

From any screen in Frontier:

» Click on the Customize keyboard map icon.

The Keyboard Mapping window displays:

Keyboard Mapping

[ Select a Key

DDDDDDDDIDEDDZ [Dl I

DDDI I I N DED

e L L L LT ) LI
Bu”ulm | D DID

[ List of custom shortcuts [ List of default shortcuts

Shortcut Action Type Action Name Shortcut Action Name

Cursor Left ® ON

- Cursor Right ® ON
cursor Up ® ON OFF

Cursor Down ® ON
BACKSPACE Backspace ® ON © OFF
CTRL Reset ® ON © OFF

CTRL+ Move Mark Left ® ON O OFF

» Click on the key or combination of keys you want to assign as a keyboard shortcut.

Note: The system hides all keys that cannot be used in combination with the one selected. This is to prevent selecting
a combination that is not available either because there is a default/custom shortcut assigned to those keys or because
it has aspecific function in the browser program or operating system.
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The Select a Key-Action pop-up displays:

Select a Key-Action
’7 Keys: CTRL(L) + § Type: Macros = Name: Macro 1 ~

» Click on the Type drop down menu and select Macros or Functions depending on the shortcut you are creating.
» Click on the Name drop down menu to display the list of macros and functions that can be assigned
to theselected key(s).
» Click on the Assign action button.
» Click on the Save button.

Note: Keyboard shortcuts are active after clicking on the Save button. They are in effect on any Frontier screen where
you aresigned on.

The following examples show how to set up keyboard shortcuts for macros and functions and how to override
andrestore a default shortcut.

Example 1: Macros

The following example shows how to create a keyboard shortcut that runs a macro when pressing on the Ctrl
+ S keyssimultaneously.

From the Keyboard Mapping window:

» Click on the left Ctrl key on the keyboard map.
» Click on the S key on the keyboard map.

The Select a Key-Action column displays:

» Click on the Type drop down menu and select Macros.
» Click on the Name drop down menu and select the macro to assign to the selected keys.
» Click on the Assign action button.
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The keyboard shortcut displays in the List of custom shortcuts list:

— List of custom shortcuts

Shortcut Action Type Action Name
CTRL{L)+ & Macros Macro 1 n

» Click on the Save button.

The keyboard shortcut is active.

Example 2: Functions
The following example shows how to set up a keyboard so that the * key on the numeric keypad executes F4.

From the Keyboard Mapping window:

Click on the * key on the keyboard map.
Click on the Type drop down menu and select Functions.
Click on the Name drop down menu and select Program Function Key 4.

vV Vv Vv Vv

Click on the Assign action button.

The keyboard shortcut displays in the List of custom shortcuts:

— List of custom shortcuts
Shortcut Action Type Action Name
CTRL[L)+ & Macros Macro 1 n
NUM * Functions Program Function Key 4 n

» Click on the Save button.

The keyboard shortcut is active.
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Example 3: Overriding a Default Shortcut
The following example shows how to override a default shortcut:

From the Keyboard Mapping window:

» Click on the Ctrl key on the keyboard map.

The Select a Key-Action pop-up displays with a Warning message to advise you the selected key combination is
assigned to another function:

Select a Key-Action

Key: CTRL(L) Type Macros ~ Name: Macro 1 -

» Click on the Type drop down menu and select Macros.
» Click on the Name drop down menu and select the appropriate macro.
» Click on the Assign action button.

The keyboard shortcut displays in the List of custom shortcuts:

— List of custom shortcuts

Shortcut Action Type Action Name

CTRL(L) Macros Macro 1 n

The default shortcut is turned OFF and greyed out. Turning it back ON deletes the custom shortcut that currently
overrides it.
» Click on the Save button.

The keyboard shortcut is active.
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Example 4: Reinstating a Default Shortcut
The following example shows how to reinstate a default shortcut that was overridden by a custom shortcut:

From the Keyboard Mapping window:

» Scroll down to the greyed-out shortcut that you wish to reinstate in the List of default shortcuts box and click
the radio button beside ON.

OR

» Click on the Delete u icon beside the custom shortcut in the List of custom shortcuts box.
» Click on the Save button.

The custom shortcut assigned to this key is deleted and the default shortcut is active again and no longer
greyedout.

Recommended Shortcuts for Laptop Users

If you use a laptop and you do not have an external numeric keypad, it is recommended that you add the
followingkeyboard shortcuts:

/ Field + (Enter)

\ Field -

Other Recommended Shortcuts - Set to your Own Preferences

/ (On numeric keypad) F2 » Used for Order Now in APO

* (On numeric keypad) F7 » Used for moving back one product on the Order Analyze
screens

. (On numeric keypad) F4 » Used for scheduling future orders on regular orders

Home F15 » Needed on some screens to get to F10

End F10 » Used for changing APO promo levels at a glance
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Chromebook Users

If you use a Chromebook to access the Frontier system, we recommend that you set the following shortcuts for
F23 (Shift+F11) and F24 (Shift+F12).

Shift + F11 F23 » Needed on some Frontier screens to access additional functions

Shift + F12 F24 » Needed on some Frontier screens to access additional functions
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Tablet/Mobile Functionality

One advantage of Frontier now being a web-based solution is that it is available on a variety of mobile devices.
Frontier has been tested and works best on iOS and Android devices using Safari or Chrome web browsers.

Minimum Support Device Minimum Operating System Requirement*

» iPad » i0S 11 or higher
» iPhone » i0S 11 or higher
» Android Tablet » Android version 7 or higher
» Android Smartphone » Android version 7 or higher

*Frontier may also work on devices other than the above, however you may experience impaired functionality.

TIP: Frontier displays the best on an iPad or Tablet in portrait mode.

You must connect to a Wifi network that has access to your Store’s Frontier system. Example: the 20Dealer08 network
withinyour Store. Outside your Store you need to use Global Protect to connect. Refer to the Global Protect User Guide to
set up this access.

There are three soft keypad views:

123 Numeric Keypad — Makes product number entry faster
FXX Function Key Keypad — Allows access to all available Function Keys

ABC Native Keyboard — Displays the keyboard available on your device to allow numbers, letters and other
characters.
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These keypads can be displayed or hidden depending on your preferences or the task being performed:

kY]

» Scroll left and right to display all 24 Function keys, plus other common page navigation keys.

» Draganywhere on the screen by tapping and holding anywhere on the keypad.
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» When you have product pictures turned on, you can move the picture window anywhere on the screen to allow it to
be visible with the various keypads open.

» Frontier displays both in portrait and landscape mode and auto-fits to your device’s screen (Portrait mode is
recommended so that less of the screen will be hidden when the virtual keyboard is displayed).

» Bluetooth and other external keyboards are supported to give you a full physical keyboard.
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» PDFs of your reports can be accessed on mobile devices allowing you to either view, save or send.

Note: The CSV and TXT reports are also available however you may need to download additional applications to view them on
yourdevice. This may differ by device.
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Floor Inquiry Screen

The Floor Inquiry screen menu option 01/02 provides a lot of information about the products and their availability at
your Store. Understanding this screen is essential for providing customer service. This document takes you through
how to readthe Inquiry Screen and some of the functionality on the screen.

Understanding the Floor Inquiry Screen

Familiarize yourself with the features of the Floor Inquiry screen below:
Note: F1 = Help — It is available on this screen (as it is for most Frontier screens) to learn more about specific fields. To use this

feature,move your cursor to the field you want to learn more about and press the F1 key and an information box displays.

Floor Inquiry
Aid E i Red Pro

Product Number — Type the product number in this field to search for information of products.
Product Status
Store Status — Identifies the status of the product at your
Store.A=Active which means your Store carries the product.
I=Inactive which means your Store has ordered it before but no longer carries it
N=Non-stock which means the product is new and your Store has not ordered it yet or your Store does not carry
theproduct due to Store size or market.
Corporate Status - Identifies the status of the product at your

Store.A=Active indicates this product is available for ordering.
S=Seasonally Discontinued indicates the Corporation is not currently carrying this product.

F=Fully Discontinued indicates the Corporation is no longer carrying this product. A Store is not able to order
theseproducts, even if it has inventory in the Store.

T=Temporarily Discontinued indicates the product is temporarily unavailable.

X=Not Stocked by the Corporation indicates it is not a Corporate product and the Store has obtained it locally or it is
notavailable for sale.
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Price Information — Regular Price is the standard price of the product. If there is a price beside the Promo Price, the product is
on sale.

On Hand — Displays the quantity of product you have at your Store
RetailOH — The quantity on hand of the product.
A letter following the number is called an Enhanced Reserved Inventory (ERI) code. The quantity reserved may not be included
in the total RetailOH.
D = a quantity of this product is used for display.
Q = a quantity of this product is in quarantine.
@ = a quantity is reserved for an Online order.
O = a quantity is reserved for other reasons.
S = a quantity of the product is a substitute product.
Location — List the location(s) where the product can be located on the retail floor and warehouse. The primary location
name is highlighted. Press F8 on each location to provide additional information about the BinCap (or how many of each
product can be stored at each location). BinRet — The first number shows how many of the product can fit on all locations of
the retail floor; the second number shows how many of the product can fit in all locations of the warehouse.
Environmental Fees — Government mandated extra fee on certain products that must be collected when the product is
purchased (ex. Motor Qil).
Rain Check — Indicates if a Rain Check can be issued for this product if it is sold out.
Y — Yes, you can issue a Rain Check. N — No, you cannot issue a Rain Check.
Substitutes and Related Products — Displays similar products the customer may be interested in if the current product is
unavailable.
Order Dates — These fields indicate the estimated date you can expect to receive the next shipment, which can be helpful
whenspeaking with customers who want products that are currently not available.
Note: These dates are not 100% accurate.
Lst Order — The date the product was last ordered (YY/MM/DD).
Str due — The most probable date (YY/MM/DD) the products will arrive at your Store.
Product Picture — Displays picture of the product.
On Order Information -When a product is On Order these fields indicate the order type and quantity.
Reg Order — Total number of units on order for all Regular Orders for this product.
Promo Order — Total number of units on order for all Promotional Orders for this product.
Placing Order — Total number of units on order for all Seasonal Set-up and Placing Deals for this product.
Standing Orders — Total number of units placed on Standing Order (Back Order) by Home Office because the requested
guantity was not available when the order was placed.
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F7 = Lost Sales — A function that records when a product was wanted by a customer but was not in stock. This information is sent to
theperson responsible for ordering. Speak with your manager to see if your Store uses this function.

F8 = Location Details — Used to display All Locations for the product selected. From here you can also display F8=Last Known Locations
when locating products without a Location.

F10 = Substitutes and Related Products — Displays similar products the customer may be interested in if the current product is
unavailable.F14 = Send Message to Office — Use this function when you would like to send a message to the office regarding a specific

product.

You can request; 1=Inventory Audit, 2=Order Request or 4=Message (such as “Damaged”). Speak with your manager to see if your
Store uses thisfunction.

F17 = Remote Store Inquiry — This function checks inventory levels of the product selected at other Stores in your area. This is used
when an item in your Store is not in stock and you would like to locate it at another Store for a customer.

F18 =Frontier Search — This function allows you to search for products in your Store when you do not know the product
number. You can search by; product description, product name, UPC and product number.

Other Function Keys
Where used

F4=Display warranty information
F14 send [|'|1I])-"| fo vrt]ixl'
Additional product info Fi16=Manager inquiry
f
f

Display comments
Remote store !l|l]|lilll 18=Product r1|;1|x-1 search
20=Select product by fineline
Select {1[11|]I]1 t by numbei 22=Selec [1[||1i|)| i bu UPI H

Select i;!:n]l]( t |\|| class

adjustment history

Search

This document introduces you to Frontier Search. The Frontier search screen appears by default and has more
information than the traditional Alpha search, but you can use either one of those product look-up options.

Accessing Frontier Search

From the 01/01 or 01/02 screen:

» Press F18.
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The Frontier Search screen displays:

FRONTIER SEARCH Search by Keyword - - Classic View e (@

Search Results osewehrenits | w0 ” |

Prouct Number Prouct Name Price OnHand ~ Dasliodkator  LoysityBonus  Subit/Ressrve  Status

» Search by keyword or product number. Searches can include; product name, description, product number orUPC
code.

The search results display:

A
FRONTIER SEARCH Search by Keyword - J | hockey stick Classic View Nnes ()
Product Class Search Results 1277 Search Results ;ZSDH P‘*Ei
[ 46 Home hardware (1)
[ 51 Christmas trees... (1) C
D 74 Auto parts (859) Product Number « Product Name Price Deal Indicator Loyalty Bonus On Hand Subst./ Reserve Status Location
[ 83 Hockey & skatin... (411)
O 95 Outside purchas... (1) L 83-0197-4 D JODGOAL $14.99 N/A Display on Floor Inquiry E
More...
Fineline I 83-1694-4 GLSTK, WARRCR4 SR L $99.99 1362 N/A Display on Floor Inquiry
[ 12287 Fma - auto safe... (4)
[ 50409 Christmas decor... (| |
[ 65401 Intermediate co... (2 17) | 83-8308-4 STK.SHW T1000 JRL'SH $24.99 318 N Display on Floor Inquiry
- [ 65402 Junior composit... (136)
D [0 65404 Senior composit... (€ 35) \
More.. 83-8406-0 STKBRVLTPROSR.L $199.99 1362 N/A Display.on Floor Inquiry,
-
OnSale \
[0 Regular Price (1277) \ 83-6407-8 STK,BR VLT PRO SRR $199.99 1362 NF Display on Floor Inquiry
Ny
Store Status / Corp Status 83-8442-2 STK, BRVOLT JR,L $64.99 1362 NA Display on Floor Inquiry
O nA391)
O n/F (s84)
Onre) Y 83-8443-0 STK, BRVOLT JR,R $64.99 1362 NF Display on Floor Inauiry
~
OnHand 83-8449-5 STK,BRVOLTINT.L $69.99 1362 NA Display on Floor Inquiry
A. Search for Products.
B. Filter by Product Class, Fineline, On Sale, Product Status or On Hand to narrow results.
C. Sort the results by clicking on the column Header.
D. Select your product by clicking on the Product Description link.
E. Display your product on the Inquiry screen by clicking on the Display on Inquiry Screen link.
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The Product Details page displays:

FRONTIER SEARCH seachbykenord  ~ | | B A oo -wcp

View on Canadiantire.ca

Bauer Vapor Volt Pro Composite Hockey Stick, Senior, Left

83-8406 Showall products within fineline
$199.99 Last deal:

(Cin-Store Promotion ) (_Rainchecks )

Product Features

\ On Hand: 0

On Order: 0

s
r"‘“
.

Location:

Order Information Warranty Status
Regular: 1 30Days 20/01/18
Promo: \ No repair N/T
Standing: 90

Last Ordered: 0/00/00

Last Received: 0/00/00

Received Quantity.

Access the traditional Alpha Search capability using the Classic View toggle.
Change the Language option from English to French.
Click on the View on canadiantire.ca link to display the item on the Canadian Tire website.
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Progress Bar

The Work with Active Jobs Screen provides an estimate of job completion time, which means you can determine
whether to wait for tasks to complete or move on to another task.

Accessing the Progress Bar

1. Go to menu option 03/08/02. The Work With Active Jobs screen displays:

Work With Active Jobs S052
5/14/20 09:40:42

Active jobs:

Current Status
Opt Subsystem/Job User ETA
AMS
AMSMON QPGMR RUN
CTCMQ
DIMEMT QPGMR RUN 5/12/2

» All jobs currently running are listed.
» The Time column shows the time the job started to run. For jobs that just started, the ETA column will say RUN

until an ETA has been calculated.

Note: The first time a job is run on your system, it will not show an ETA. On subsequent runs, the ETA is calculated by taking
an average of the last 5 times the job was run. No ETA is shown when the job takes 1 minute or less. Once the expected time
of completion is known, this shows how much time remains for the job to finish. For monitor jobs (e.g. AMSMON), this will

always say RUN.
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System Monitoring (Health Monitor)

The Frontier Health Monitor screen is where you check to see if there is a problem. For services with a red light,
you must call the Retail Systems Service Desk (RSSD).

Go to menu option 03/08/02 and press the F10 key. The Health Monitor Screen displays:

F RON TI ER H EALTH MON ITO R If any of these services are red, contact RSSD. [

Status Service Severity info Last updated

' Flash drive for backup in USB port Critical @ 20210531 10:51:38 Test
' Frontier Desktop | RF Gun Critical @ 20210831 15:04:17

' POS critical @ 20210531 15:04:17

' Inbound / Outbound messaging Critical @ 2021-05-31 15:04:17

' Frontier Job Manager (JOM) Critical @ 2021-06-31 15:04:17

! EFD Online Orders / Hybris Critical @ 2021-0531 15:04:17

‘ EFD Product Toolbox | EUC Medium @ 20210531 15:04:17

' Costar Medium @ 20210631 16:04:17

‘ Printers (CUPS) Medium (D 2021-08-31 15:04:17

! Price Verifier Low @ 2021-0831 15:04:17

! Frontier Search Low @ 2021-0831 15:04:17

» Clickonthei G)icon.

Additional information about the system component displays:

Inbound / Outbound messaging

Status Service

' integration war
' InboundQueue
' inboundErrorQueue

- -

» Call RSSD at 1-866-899-3025 for further assistance if any of the stoplights are red.
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File Upload
This function allows you to upload files for use with certain functions such as the Inventory audit file

prepared by a third party company counting the Store’s inventory (WISFIL) or upload the Webshop file.
Follow these steps to upload WISFIL.

WISFIL Upload (Admin users only)

If the Store is undergoing a Dealer changeover, an outside company (RGIS or Western Inventory) performs an
inventory count and prepares a file with the quantities to apply to the inventory audit batch that was created
for the changeover. Follow these steps to upload this file.

From any screen in Frontier:

» Click on the File Upload icon on the toolbar.

The File Upload window displays:

File Upload

WISFIL Upload Browse:
Webshop Choose a file
Information

Upload

Close

» Click on the Choose a file button under Browse.
» Navigate to the WISFIL file that is saved to your computer and open it.
» Click on the Upload button.

The file uploads to the server where it can be subsequently imported (Menu option 14/07) into the
audit batchcreated for the changeover.
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Using Webshop

When there is a Webshop special, the Excel file can be uploaded into Frontier so that it displays details about
the special, such as the price, on screens that display product information (Floor Inquiry, Manager Inquiry, Store
AnalysisMaintenance, Analyze Regular Order, etc.).

Note: The Webshop file is emailed weekly. Save it to a folder on your computer before performing the file upload.

Follow these steps when you receive a new Webshop file that you want to consider when analyzing products on
Inquiryor Order Analysis screens.

From any screen in Frontier:

» Click on the File Upload m icon in the toolbar.

The File Upload window displays:

File Upload

WISFIL Upload Browse:
Webshop Choose a file
Information

Upload

Close

» Click on Webshop Information from the list.
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The Webshop Information window displays:

File Upload

WISFIL Upload Browse:

Webshop Choose a file
Information

Select XL S Sheet to Use:

() Eastern Promotions

@ Western Promotions

Enable Webshop Information Popup:
@® On

O off

Close

» Click on the Choose a file button under Browse.

» Navigate to the Excel file that you received with the Webshop specials and open it.

» Click on the Eastern Promotions or Western Promotions radio button under Select XLS Sheet to use
dependingon if your Store is considered an Eastern or Western Store.

» Click on the On radio button under Enable Webshop Information Pop-up.

» Click on the Save button.

A pop-up automatically displays with details about the special on Inquiry and Order Analysis screens that you
display for products in the Webshop special.

Note: The pop-up window automatically displays at the bottom right corner of the screen but can be dragged to another
part of the screen. For more information on using the Webshop tools, refer to the Using Excel Tools section.

Disabling the Webshop Information Pop-up

Note: The Webshop pop-up continues to display the items until a new Webshop file is uploaded or the pop-up
is disabled. For example, if you load week 15 items but forget to load week 16, week 15 items continue to
display until you load week 17 or you delete the file or disable webshop popups.
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Follow these steps to disable the Webshop pop-up when the Webshop special is over so that it no longer displays
onthe Inquiry or Order Analysis screens:

From any screen in Frontier:
» Click on the File Upload icon in the toolbar.

The WISFIL Upload window displays:

File Upload

WISFIL Upload Browse:
Webshop Choose a file
Information

Upload

Close

» Click on Webshop Information from the list.

The Webshop Information window displays:

File Upload

WISFIL Upload Browse:

Webshop Choose a file
Information

Select XL S Sheet to Use:

() Eastern Promotions

@ Western Promotions

Enable Webshop Information Popup:
@® On

O off

E=]E=

Close

» Click on the Off radio button under Enable Webshop Information Pop-up.
» Click on the Save button.
The Webshop details no longer display.
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Split Screen

The Split screen feature (Shift + ESC + 1) is not available in Frontier.

You can open sessions in new tabs (click on a new tab on the browser toolbar) or you can have another
session in a second browser window (and toggle between them using Alt+Tab).

Split screen on RF Guns (toggle between multiple screens on the RF Gun): Press Ctrl + K or press the Green dot
button (9200 model guns) or press the P1 button (9300 model guns) on the top left of the keypad.

Tip: To toggle between tabs without using the mouse, use the shortcut Ctrl + Tab. The shortcut Ctrl + Shift + Tab selects
the previous tab.

F1 Help

The F1 Help feature is available on almost every screen. Follow these steps to access the F1 Help window:

From any screen in Frontier:

Work with Employees

» Click the field that you need help with.
» Press the F1 key.
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The Help pop-up displays:

» Click on the F3 Exit Help button to close the pop-up.
OR

» Click on the close icon.

Contact Retail Systems Service Desk (RSSD) 1-866-899-3025 if you require further assistance.

Workstation Management

A workstation is a name used to identify a particular device used to access Frontier. Some workstation name
examplesinclude: Paint, Housewares, and Customer Service. Frontier requires a specific workstation name for
certain functions.

In Frontier, a workstation name must be assigned for anyone wishing to use the Customer Returns and Signage
menusto enable printing. Workstation names need to be defined in advance before the user can access these
programs.

The following section outlines the steps to create shortcuts, set up Workstation names for Customer Returns,
Signageand Daily Sales Messages and the steps to send messages to Workstations.

From the Master Menu:

» Type options 06/09.
» Press the Enter key after typing each option.

o
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The Work with Customer Returns Workstations screen displays:

» Press the F6 key.
The Add/Change Workstations pop-up window displays:

Add/Change Workstations

Workstation name
5.5 cher printer . for
icher printer . . (2 for

it printer . . . (? for

Stocklist group (? for 1list)

F12=Previous

» Type the Workstation name in the Workstation name field.

» Type the name of the printer where the 5.5” return vouchers print in the 5.5” voucher printer field.

» Type the name of the printer where the 11” return vouchers (tire and battery warranties) print in the 11”
voucher printer field.

» Type the name of the printer where returns Stocklists print in the Stocklist printer field.

Note: The same printer can be used for the 5.5” return vouchers, 11” vouchers and the Stocklists.
» Type the Workstation’s stocklist group number in the Stocklist group field.

Note: The number you type in the Stocklist group field determines which returns products are included when printing a
CustomerReturns Stocklist. To print the Stocklist, you select a Stocklist group. The list that is created includes all the
returns entered on thecomputers in the selected group. In most cases, Stores will print a single list using option 1 for
the Stocklist group for all Workstations.

» Press the Enter key.
» Repeat these steps on all workstations used to process returns.

Note: If you created three shortcuts with different workstation names on the Customer Service computer, follow these
steps for each of the workstation names entered in each shortcut.
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From the Master Menu:

» Type options 30/43.
» Press the Enter key after typing each option.

The Work with Signage Workstations screen displays:

Work with Signage Workstations

» Press the F6 key.

The Work with Signage Workstations screen displays two columns of input fields:

Work with Signage Workstations

» Type the Workstation name in the Workstation field.
» Type the Printer name in the Printer Name field.

» Repeat these steps for each Workstation that is used to print signage. Page down if additional fields are
needed.

» Press the Enter key.

®
STTPR Sy Development 51 | June 2021




FRONTIER COMPUTER OPERATOR REFERENCE GUIDE

From the Master Menu:

» Type options 11/51.
» Press the Enter key after typing each option.

The Canadian Tire Control File screen displays:

Canadian Tire Control File.

Page 1.
STORE NUMBER: 970

» Type the Workstation name in the What Messages Queue Should Daily Sales Send Message to field where

messages about Daily Sales processing should be sent (e.g. Computer Operator Workstation).
» Press the F5 key to save the change.

Best Practice: It is a good idea to assign the Daily Sales Messages to send to the Workstation where the first person

would typically sign in. This allows any messages related to Daily Sales to be actioned immediately (i.e. Computer
Operator, Dealer etc.).

= O
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From the Master Menu:

» Type options 03/04/12.
» Press the Enter key after typing each option.

The Work Station File Maintenance screen displays:

Canadia ire Corporation
Work Station File Maintenance

ADD

WORK STATION WORK STATION LOCATION

Note: If you have never entered Workstations on this screen, it automatically displays with blank fields where you can
enter Workstation names. The screen displays ADD at the top to indicate that you are currently in Add mode. If there

are Workstationslisted, press the F5 key to access Add mode.

» Type the Workstation name in the Work Station field.
» Type the location of the computer in the Description field.

Note: This is the name that displays when selecting Workstations to send a message to.

» Repeat these steps for each Workstation. Page down if additional fields are needed.
» Press the Enter key.
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From an internet browser:

» Type the Frontier URL.
» Type /?workstation=XXX following the Frontier URL (where XXX is the Workstation name you want to use).

The Workstation name displays on the Sign On screen:

Note: You cannot have two Frontier windows with the same Workstation name signed on at the same time. If you
are currently signed on to a Workstation in Frontier and you open a second browser tab with the same Workstation
name, the Sign On screendisplays. If you sign on in the second browser tab, the session in the first tab immediately

signs off.

Viewing Who Is Signed On

Frontier allows you to see what Workstation names have been defined in the system and which user is signed
on.Follow these steps to access the Work with Workstations screen:

1 From the Master Menu:

» Type options 59/05.
» Press the Enter key after typing each option.
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The Work with Workstations screen displays:

Work wj A stations C E
Show 10 v entries B D Search:
Workstation Name Signed On “irst Used Last Signed On User Name
LCARS N 2018-11-21 07:44:29 2018-11-21 14:43:05
QPADEV1007 Y 2018-11-21 08:03:40 2018-11-21 08:03:45 DEALER_1
QPADEV4269 N 2018-11-21 09:15:02 2018-11-21 09:15:33
QPADEV5407 Y 2018-11-21 11:44:21 2018-11-21 15:30:03 DEALER_1
QPADEV7904 Y 2018-11-21 10:10:51 2018-11-21 13:45:49 DEALER_1
QPADEVEST74 N 2018-11-21 08:27:21 2018-11-21 09:53:49
QPADEVS083 N 2018-11-21 10:53:25 2018-11-21 11:42:19
Showing 1107 of 7 entries Previous - Next

Workstation Name: Displays the name of the defined Workstations.

Signed On: Indicates a Y if a user is currently signed on and an N if no user is signed on.
First Used: The first time the user signed on to the Workstation.

Last Signed On: The most recent date and time of the last sign on for that Workstation.
User Name: The user who is currently signed on if applicable.
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Print Function

All reports created in your Store are listed on the Work with Print Output screen. You can display, print, save
and deletethem. Follow these steps to access and work with reports generated in your Store:

From any menu:

» Press the F10 key on the keyboard.

The Work with Print Output screen displays in a new tab in the browser:

A Work with Print Output
 Raprt v T | | Trvwen s g nae | [ | - |
Report Name Report ID User Name Job AutoP | Printer Pages Size (MB) Date Link
Shipment Contents EQZQPFR SHAWN Yes PRINTER1 1 004 20210531 124024 || oy B}
Late Deal Delivery Claim Form JeliveryClaim  TRACY DGSLDRRPT Yes PRINTER1 1 0.04 2021053123148 || o lﬁ ) B
2
Dealer Claims Sent to Home Office ICDPRTOA TRACY TALK_DCLAIMSTO000  Yes PRINTER1 1 004 2021053112303 | o i)
Summary Exception Repart EXCRTSUM TRACY EXCRTSUM Yes PRINTER1 1 004 20210831 122440 | o MR
Inventory Receipts List EQWHPFR QPGMR IINVNLIST Yes PRINTER1 1 004 20210531 11012 || o B ol)
Inveice Summary ERUZPFR QPGMR IINVNLIST Yes PRINTER1 1 004 20210531 111012 | ooy B}
Adjust History Report EQVTPFR GABBY ADJHSTPRT Yes PRINTER1 1 0.04 2210531101721 | oy B)
Adjusta-card Maintenance Audit Report IRTPRTO7 TRACY Yos PRINTER1 1 0.03 20210 4345 | e ﬁ\ )
Product Information Received From H.o ICDPRT17 QPGMR TALK_EPRDINFOO000  No 10 012 20210531 080213 || oy B}
tod ION| Record List 3 PGMR Gl Yes PRINTE Py 2021.05.31 0B:0: >
Automated IONI Record Lis! EQGIPFR PGMR EQGIPFR Yas PRINTER1 1 004 021.05-31 08:02:12 Eiﬂj
Ministd Pack Size Maintenance From H.O. EQQ7PFR QPGMR TALK_PMO000050000  No 2 0.05 2021-05-31 08:02:11 =) @\ J
7
Audit Trail For Pricing Discrepancies PCCTRAP QPGMR TAXPOS0007 No 1 004 2210531050450 || ooy B
) Augitdimmart - Additions/changes 030_ADI ANG M ).0. 21-05-31 05:04.5 5
LU Aud 1 - Additions/changes \EFEM,J ADD.CHANG ~ QPGMR TAXPOS0007 No 1 004 20210531 050458 || oy Bl
I C D Showing 126 1o 150 of 4,893 entries Previous 1 5 6| 7 186 Next
e — D I

On this screen you can:
Search for a report Print a report

View and save a report Delete a report
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If many reports are listed on the Work with Print Output screen, you can use the filters to search for a specific report.

From the Work with Print Output screen:

A B C D & with Print Outpt E F - @
RaprtName | 2 | | B3 | T | - 1
i Report Name Report ID User Name Job AutoP | Printer Pages Size (MB) Date Link
|
Shipment Contents EQZQPFR SHAWN Yes PRINTER1 1 004 2021-05-31 1240 24 ma \ﬂ
Late Deal Delivery Claim Form LateDealDeliveryClaim TRACY DGSLDRRPT Yes PRINTER1 1 0.04 2021-05-31 12.31:48 ma :ﬂ
Form
Dealer Claims Sent to Home Office ICDPRTO1 TRACY TALK_DCLAIMSTO000  Yes PRINTER1 1 004 2021-05-31 1230 36 ua ﬂ
7
Summary Exceplion Report EXCPTSUM TRACY EXCPTSUM Yes PRINTER1 1 0.04 2021-05-31 1224 40 ma \ﬂ
Inveniory Receipts List EQWHPFR QPGMR IINVNLIST Yes PRINTER1 1 0.04 2021-05-31 11210012 ma :ﬂ
Invoice Summary ERUZPFR QPGMR NINVNLIST Yes PRINTER1 1 004 2021.05-31 1110012 maﬂ
() Adjust History Report EQVTPFR GABBY ADJHSTPRT Yes PRINTER1 1 004 2021-05-31 1001721 ma ﬂ
Adjusta-card Maintenance Audit Report IRTPRTO7 TRACY Yes PRINTER1 1 0.03 2021-05-31 09.43.45 ma \ﬂ
Product Information Received From Hao ICOPRT17 QPGMR TALK_EPRDINFOO000  No 10 012 2021-05-3108.0213 ma \_'ﬂ
7
Automaled IONI Record List EQGIPFR QPGMR EQGIPFR Yes PRINTER1 1 0.04 2021-05-31 080212 ma\ﬂ
Min/std Pack Size Maintenance From H.O. EQQ7PFR QPGMR TALK_PMO00D00S0000 No 2 0.05 2021-05-3108:0211 ma Lﬂ
7
Audtt Trail For Pricing Discrepancies PCCTRAP QPGMR TAXPOS000T No 1 004 2021-05-31 0504 59 ma \ﬂ
PLU Audit Report - Additions/changes IFERO30 ADD.CHANG ~ QPGMR TAXPOS0007 No 1 0.04 2021-05-31 05:04.58 ma :2]
E
Showing 126 to 150 of 4,893 entries Pravious 1 5 6 T 196 Next
3

Click the Report Name field and type the Report name.

Click the Report ID field and type the Report ID.

Click the User Name field and type the Username.

Click the Job field and type the Job name.

Click on the Select Printer drop down menu and select the Printer.
Click on the Date drop down menu and select the date.

Click on the Filter button.

G Mmoo ® >

The filtered reports display:

» Click on the Reset button to clear the filters and display all reports.

Note: The Reset button is a browser button. It is called Reload or Refresh in most browsers.

Note: You can look up a report by using one or more of the filters. You do not have to use all filters to search for a report.
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Follow these steps to view a report in PDF, TXT or XLS format.

From the Work with Print Output screen:

Work with Print Qutput Stow[25_wlenres (7)
Repor Hare e | | T | | - | |
[ Report Name Report ID User Name Job AutoP | Printer Pages Size (MB) Date Link |
Shipment Conlents EQZQPFR SHAWN Yes PRINTER1 1 004 2021-05-31 1240 24 ma \L‘] |
Late Deal Delivery Claim Form \;alcUm\Dcll'mryCIalr' TRACY DGSLDRRPT Yes PRINTER1 1 004 2021-05-3112.31.46 = a d
om
Dealer Claims Sent to Home Office ICDPRTO1 TRACY ';ALKJ!CLNMSTOI]OEI Yes PRINTER1 1 004 2021-05-31 123036 ua d
Summary Exception Report EXCPTSUM TRACY EXCPTSUM Yes PRINTER1 1 0.04 2021-05-31 1224 40 o a \:]
Inveniory Receipts List EQWHPFR QPGMR IINVNLIST Yes PRINTER1 1 0.04 2021-05-31 1110112 ma ﬂ
Invoice Summary ERUZPFR QPGMR NINVNLIST Yes PRINTER1 1 004 2021.05-31 1110012 maﬂ
Adjust History Report EQVTPFR GABBY ADJHSTPRT Yes PRINTER1 1 004 2021-05-31 1001721 Wa d
Adjusia-card Maintenance Audit Report IRTPRTO7 TRACY ‘Yes PRINTER1 1 003 2021-05-31 09.43.45 = a \ﬂ
Product Information Recerved From Ho ICOPRT17 QPGMR IALK EPRDINFOO000  No 10 012 2021-05-31 08.02.13 ma L'ﬂ
Automaled IONI Record List EQGIPFR QPGMR EQGIPFR Yes PRINTER1 1 0.04 2021-05-31 08.0212 ma\ﬂ
Min/std Pack Size Maintenance From H.O. EQQ7PFR QPGMR ;TALK_PMGOUOUGDUOU No 2 005 2021-05-3108.0211 ma ﬁ
Audit Trail For Pricing Discrepancias PCCTRAP QPGMR TAXPOS000T No 1 004 2021-05-31 0504 59 = a \ﬂ
PLU Audit Report - Additions/changes IFER030ADD.CHANG ~ QPGMR TAXPQS0007 No 1 004 2021-05-31 05.04.58 ma d
E
Showing 126 to 150 of 4,893 entries Pravious 1 5 6 7 196 Next o
e o]

» Click on the PDF/TXT/XLS icon to view a report.
» If you clicked on PDF, the report displays in a new browser tab.

Note: The report contents are the same in every format.
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Follow these steps to save a report on your computer as a PDF, Text or Excel file.

From the Work with Print Output screen:

Work with Print Output Show[25_vlennes  (7)
Rt Name | =X | | B3 | T | - = |
) ReportName Report ID User Name Job AutoP | Printer Pages Size (MB) Date Link
-
[ Shipment Contents EQZQPFR SHAWN Yes PRINTER1 1 004 2021-05-31 1240 24 ma \ﬂ
Late Deal Delivery Claim Form LateDealDeliveryClaim TRACY DGSLDRRPT Yes PRINTER1 1 0.04 2021-05-31 12:31:46 ma :2]
Form
Dealer Claims Sent to Home Office ICDPRTO1 TRACY TALK_DCLAIMSTO000  Yes PRINTER1 1 004 2021-05-31 12:30°:36 ma ﬂ
7
Summary Exceplion Report EXCPTSUM TRACY EXCPTSUM Yes PRINTER1 1 0.04 2021-05-31 12 24 40 ma \ﬂ
I Inveniory Receipts List EQWHPFR QPGMR IINVNLIST Yes PRINTER1 1 0.04 2021-05-31 1121012 ma :ﬂ
Invoice Summary ERUZPFR QPGMR NINVNLIST Yes PRINTER1 1 004 2021-05-31 1111013 maﬂ
[ Adjust History Report EQVTPFR GABBY ADJHSTPRT Yes PRINTER1 1 004 2021-05-31 1001721 ma ﬂ
Adjusta-card Maintenance Audit Report IRTPRTO7 TRACY Yes PRINTER1 1 0.03 2021-05-31 09:43 45 ma ﬂ
Product Information Received From Hao ICOPRT17 QPGMR TALK_EPRDINFOO000  No 10 012 2021-05-31 08.0213 ma \_'ﬂ
7
Automaled IONI Record List EQGIPFR QPGMR EQGIPFR Yes PRINTER1 1 0.04 2021-05-31 08.0212 ma\ﬂ
Min/std Pack Size Maintenance From H.O. EQQ7PFR QPGMR TALK_PMO00D00S0000 No 2 0.05 2021-05-31 08:02:11 ma ﬂ
7
Audtt Trail For Pricing Discrepancies PCCTRAP QPGMR TAXPOS000T No 1 004 2021-05-31 0504 5¢ Eﬂa \ﬂ
h PLU Audit Report - Additions/changes IFERO30 ADD.CHANG ~ QPGMR TAXPOS0007 No 1 0.04 2021-05-31 05:04.58 ma :2]
E
Showing 126 to 150 of 4,893 entries Pravious 1 5 6 T 196 Next
3

» Click on the PDF icon beside the report you want to save.
(If you click TXT or XLS, the “Save As” window appears immediately.)
» The report displays in a new browser tab.

Press the Ctrl + S keys simultaneously.

The Save As window displays:

» Navigate to the folder where you want to save the file.
» Click on the Save button.

The file is saved on your computer.

You can navigate to the folder and open the file instead of displaying it in a browser. The PDF version opens in
AdobeReader, the TXT version opens in Notepad and the CSV version opens in Microsoft Excel.

Note: If you changed your default file associations in Windows, these files may open in different programs.
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Follow these steps to delete a report.

From the Work with Print Output screen:

Work with Print Output Shou(Z5 vensies (7)
( Report Name Report ID User Name Job AutoP | Printer Pages Size (MB) Date Link |
Shipment Contents EQZQPFR SHAWN Yes PRINTER1 1 004 2021.05-31 12 40 24 ma B
Late Deal Delivery Claim Form LateDealDeliveryClaim TRACY DGSLDRRPT Yes PRINTER1 1 004 2021-05-31 123146 ma \ﬂ
Form
Dealer Claims Sent to Home Office ICOPRTO TRACY ;TALK_DCLNMSTUUOD Yes PRINTER1 1 0.04 2021-05-31 12.30.36 ma ﬂ
Summary Exceplion Report EXCPTSUM TRACY EXCPTSUM Yes PRINTER1 1 0.04 2021-05-31 1224 40 ma \l_]
Inveniory Receipts List EQWHPFR QPGMR IINVNLIST Yes PRINTER1 1 0.04 2021-05-31 11210012 ma ﬂ
Invoice Summary ERUZPFR QPGMR IINVNLIST Yes PRINTER1 1 0.04 2021-05-31 111012 ma\ﬂ
O Adjust History Report EQVTPFR GABBY ADJHSTPRT Yes PRINTER1 1 0.04 2021-05-31 101721 ma ﬂ
Adjusta-card Maintenance Audit Report IRTPRTOT TRACY Yes PRINTER1 1 003 2021-05-31 094345 ma ﬂ
Praduct Information Received From Ha ICDPRT17 QPGMR IALK EPRDINFO0000  No 10 012 2021-05-31 080213 aa \._‘]
Automaled IONI Record List EQGIPFR QPGMR EQGIPFR Yes PRINTER1 1 004 2021.05.31 08:02 12 maﬂ
Min/std Pack Size Maintenance From H.O EQQ7PFR QPGMR IALK)MGOBODSDSOD No 2 005 2021-05-31 08:0211 ma ﬂ
Audit Trail For Pricing Drscrepancies PCCTRAR QPGMR TAXPOS0007T No 1 0.04 2021-05.31 05.04 59 'Ila )
PLU Audit Report - Additions/changes. IFER030 ADD CHANG ~ QPGMR TAXPOS0007 No 1 004 2021-05-31 050458 ma ﬂ
E
Showing 126 o 150 of 4,893 entries Previous 1 5 | 8| T 196 Next
[

» Click the checkbox beside the report you want to delete.
» Click on the Delete button.

To delete all reports in the list:

» Click the checkbox at the top of the list to select all reports.
» Click on the Delete button.
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A Confirmation prompt displays:

Confirm deleting repert
files

» Click on the Confirm button to delete the report.
OR
» Click on the Cancel button to cancel.

Follow these steps to print a report.

From the Work with Print Output screen:

Work with Print Output show[2E Slenves ()
) ReportName Report ID User Name Job AutoP | Printer Pages Size (MB) Date Link
|
o Shipment Contents EQZQPFR SHAWN Yes PRINTER1 1 004 2021-05-31 1240 24 ma ﬂ
o Late Deal Delivery Claim Form LateDealDeliveryClam  TRACY DGSLDRRPT Yes PRINTER1 1 0.04 2021-05-31 12.31:48 ma :ﬂ
Form
L Dealer Claims Sent to Home Office ICDPRTO1 TRACY TALK_DCLAIMSTO000  Yes PRINTER1 1 004 2021-05-31 1230 36 ma ﬂ
7
r Summary Exception Repon EXCPTSUM TRACY EXCPTSUM Yes PRINTER1 1 004 202105311224 40 ma Tﬂ
(n Inventory Receipts List EQWHPFR QPGMR IINVNLIST Yes PRINTER1 1 004 2021-05-31 11110012 ma tﬂ
r Invoice Summary ERUZPFR QPGMR NINVNLIST Yes PRINTER1 1 004 2021-05-31 1110012 marﬂ
[ Adjust History Report EQVTPFR GABBY ADJHSTPRT Yes PRINTER1 1 004 2021-05-31 1001721 ma ﬂ
O Adjusta-card Maintenance Audit Report IRTPRTOT TRACY Yes PRINTER1 1 003 2210531 004345 3 MR
[ Product information Received From Ho ICDPRT17 QPGMR ;ALK EPRDINFOO000  No 10 0.12 2210531080213 oy M)
[ Automaled IONI Record List EQGIPFR QPGMR EQGIPFR Yes PRINTER1 1 0.04 2021-05-31 080212 ma \ﬂ
o Min/std Pack Size Maintenance From H.O. EQQ7PFR QPGMR :’MLK_PMUUUUUSWO‘J No 2 0.05 2021-05-3108:0211 ma ﬂ
o Audtt Trail For Pricing Discrepancies PCCTRAP QPGMR TAXPOS000T No 1 004 2021-05-31 0504 59 ma \ﬂ
o PLU Audit Report - Additions/changes IFERO30 ADD.CHANG ~ QPGMR TAXPOS0007 No 1 0.04 2021-05-31 05:04.58 ma L"]
E
Showing 126 to 150 of 4,893 entries Pravious 1 5 6 T 196 Next
o e

» Click the checkbox beside the report you want to print.
» Click on the Print button.
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To print all reports:

» Click the checkbox at the top of the list. All reports are selected.
» Click on the Print Selected button.

A prompt displays to allow you to choose a printer:

Select printer X

DTHPRINTER

LASRTNO1

)

L)

&= LASSVCO!
@ PRINTER1
-

SGNPRT1

» Click on the printer to print the selected report(s).

The report(s) print(s).

The following settings can be customized for any report in the system:

» Automatic printing (printer and number of copies and double-sided printing)
» Secure Output
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Only users with access to menu options 59/03 can change the report settings. This would typically only be
ComputerOperators, Dealers or Senior Managers.

From the Frontier Master Menu:

e Type options 59/03.
e Press the Enter key after each option.

The Work with Report Settings screen displays:

Frontier reporting system

& Printing Options A B C D E F G H
8 Printing Options. Mngt Reports Printing options
Show 25 v entries Search:
Report Name Report Id Auto Printer Secured Double-sided Copies Keep
a Print Printing File
13p Sales/receipts Report Y326R183 m Default v of of 1 m
Adjust History Report EQUTPFR o Dotk v o on 1 u
Adjusta-card Credit Maintenance Audit IRTPRTO9 nr Default v off off 1 m
Listing “ ks
Adjusta-card Credit Received - Report IRTPRT15CreditReceived u Defautt . of off 1 ﬁ
Adjusta-card Credit Report By Bill Of Lading  IRTPRT13 m Defalk v on o 1 m
Number g
Adjusta-card Maintenance Audit Report IRTPRTO7 ﬁ Default = off off 1 ﬁ
Adjusta-card On Hand Adjustments Audit IRTPRTO8 ﬂ Default v off off 1 ﬂ
Listing

Report Name: Displays the name of the Report.

Report ID: Displays the ID that the system uses.

Auto Print: Click on the ON button to automatically print the Report after it runs.

Printer: Click on the Printer drop down menu and select the printer where you want the Report to print.
Secured: Click the ON button so that this report is created on the Work with Secured Print Output screen
for certain users. Only users with the appropriateauthority can view these. This setting is found in menu
options 59/07/01.

Double Sided Printing: Click on the ON button to print the Report double sided or click on the OFF button to
print single sided.

Copies: Click on the minus or plus icons to select the number of copies you want to print.

Keep File: Click on the ON button to create an electronic version of the report. Do not set this to OFF for
reports that are NOT printed automatically, or you will not get the report in any form.

Printing Options, Mngt Reports: Displays the print settings for Management Reports (10/01).
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From the Work with Report Settings screen:

» Click on the Auto Print drop down menu and select ON beside the report you want to print automatically.

» Click on the Printer drop down menu and select the printer name.

» Click on Double-sided printing and select ON if you want reports to print on both sides of the page or OFF if
you want reports to print on one side.

» Click on the Copies and select the number of copies of the report you want to print.

The report(s) print automatically on the assigned printer when created in your Store.

Reports that print automatically can also be printed from the Work with Print Output screen if there is a problem
with the printer where the report was sent. You can also reprint additional copies from the Work with Print
Output screen.

The Work with Secure Print Output screen is identical to the Work with Print Output screen. Reports only display
on this screen when the report and the user who submitted it are set up for secure printing. If the report/user is
not set upfor secure printing, it displays on the Work with Print Output screen.

Note: Only users set up to view Secure Output have the option to toggle between the Work with Print Output and Work
withSecure Output screens. The Output screens for both look the same except for the additional button.

From any menu:

» Press the F10 key.
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The Work with Print Output screen displays:

Work with Print Output
portHame | = | S | EE T | a | 3 -

Report Name Report ID User Name Jab AutoP | Printer Pages Size (MB) Date Link.

Rain Check Detailed Listing EUQCPFR DEALER_1 RAINCHKRPT No 29 04z 2021.06.01 14 4451 @ a :]
Delete Associated Offerings Summary EQFPPFR QPGMR EQFLXFR No 1 003 2021.05-28 04.00:04 @ a ﬂ
Delete Associated Offerings Summary EQFPPFR QPGMR EQFLXFR No 1 003 2021-05-28 04:00:03 = ﬂ J
Agjust History Repaort EQVTPFR DEALER_1 ADJHSTPRT No 368 39 2021-05-26 10°:51:45 = a _j
Doltar Gain On Recaipt Price Dift REPORT DEALER_QC POSTINGS No 1 002 20210626 152555 o a )
(O/H Posted But Order Nat Found REPORT3 DEALER_QC POSTINGS No 1 003 2021.05-25 1525:55 = a j
Inventory Transactions. REPORT4 DEALER_QC POSTINGS No 1 003 2021055152555 g a )
Liste vérfication - ajouts/modifications LFERF,SU ADD.CHANG  DEALER_QC AIMPRCD512 No 1 004 2021-05-25 081752 a ﬂ
Liste vérification - suppressions. FER030 DELETE DEALER_QC AIMPRCD512 No 1 004 2021-05-2508:17:52 ﬂ J
Audit Trail For Pricing Discrepancies PCCTRAP DEALER_QC AIMPRCO512 No 1 003 2021-05-25 08:17:52 = a _j
Etiquattes de pnx. ERPTUPR DEALER_QC MTICKETS No 1 003 202105-25 081751 = a j
Rain Check Detailed Listing EUQCPFR DEALER_1 RAINCHKRPT No 29 042 2021-05-2108.36:44 — a _J
Delete Assaciated Offerings Summary EQFPPFR QAPGMR EQFLXFR No 1 003 2021-05-21 04 00:1 == a :']
Delete Associated Offerings Summary EQFPPFR QPGMR EQFLXFR No 1 003 2021-05-21 04:00:01 - ﬂ j
Dealar Claims Sent tn Home O CODETOL DEAIFD 1 TALK DCIAMSTONG K 1 004 024 (15 ) 4R Y

Showing 1 to 25 of 442 entries Previous 1 2 3 4 5 18 Nexd
=3

» Click on the Secure output button.

The Work with Secure Print Output screen displays the reports set up for secure output:

Work with Secure Print Qutput show[25 ] enties ()
| = | | 3 | R T | . | B2 -
Report Name Report ID User Name Job AutoP | Printer Pages Size (MB) Date Link
No data available in table
Showing 0o 0 of 0 entries evious Next
= e

»

Dealer Development
& Learning

P aas

Click on the Regular output button to return to the Work with Print Output screen.
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Follow these steps to set up users for secure printing:

From the Frontier Master Menu:

» Type menu options 59/07/03.
» Press the Enter key after typing each option.

The Work with User Profiles screen displays:

» Type 2 inthe Opt field beside the Username.
» Press the Enter key.

The Set up User Profile screen displays:

Set up User Profile

AD Signon . . . . . . . . . . ©949 _pentest
Frontier display name |
Language Ce e e . . . . E
Hide cost on Floor Inquiry

Display g . N

F3=Exit F6=WW ser Permissions F8=Load user template F10=Copy user profile

F12=Cancel F13=Reinstate popup help

» TypeYinthe Secure output field.
» Press the Enter key.
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The user is now set up for secure printing.

From the Frontier Master Menu:

» Type menu options 59/03.
» Press the Enter key after typing each option.

The Work with Report Settings screen displays:

Frontier reporting system

©f Convert *.dds -> * templates

ES Generate report Printing options

Show 25 v entries Search:
& Printing Options
& Printing Options. Mngt Reports Report Name Report Id Auto Printer Secured Double-sided Coples Keep
e - Print Printing Flle
13p Sales/receipts Report 13PerSalesRs ampsO! P ﬂ Default = ﬂ off 5 ﬂ‘
Adjust History Report EQVTPFR off Defautt . off off 1 u‘
Cd]us(a—card Credit Maintenance Audit IRTPRT09 u Default = of of 1 u‘
sting

» Click on the On button in the Secured column beside the report name.

» The report is set up for secure printing and will appear on the “Work with Secure Print Output” screen when
produced by users who are set up for secure printing. It will appear on the regular “Work with Print Output”
screen when produced by users who are not set up for secure printing.
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Job Management
This section explains the following screens you use to manage your jobs:

» Work with Active Jobs
» Work with Job Queue
»  Work with All Job Queues
» Work with Submitted Jobs

These screens allow you to see the submitted jobs in your system (these are your batch jobs). The following illustrates
theflow of batch jobs:

JOB IS SUBMITTED WORK WITH JOB WORK WITH REPORTS DISPLAY ON THE

(MANUALLY OR QUEUE SCREEN ACTIVE JOBS WORK WITH PRINT
AUTOMATICALLY) |:> SCREEN OUTPUT SCREEN
JOB LOGS DISPLAY ON THE JOM
ADMINISTRATION SITE

While a job is still in the job queue, you can change its priority in the queue (move it higher or lower in the queue), you
canrelease jobs that are on hold or you can end a job (so that it does not run). Once a job starts to run (becomes
active), it no longer displays in the job queue and displays on the Work with Active Jobs screen.

On the Work with Active Jobs screen, you can change a job’s priority (to a higher or lower number) or you can end a
job before it finishes. To prevent corrupting the data in your database, you cannot end a job that is currently updating
the database. If you try to end such a job, a message displays to advise you that the job cannot be ended. When a job
ends, any reports generated by the job display on the Work with Print Output screen. To find the reports that were
created by a specificjob, simply type the job name in the appropriate search box on the Work with Print Output screen.

Note: Refer to the Work with Print Output User Guide, for information on this screen.

When a job ends, a job log is created in the Job Queue Manager (JQM) service. To find the log for a job, you must sign
on to the JQMadministration site where you can search for the log by the job name or the date/time. This is done by
Home Office personnelwhen investigating a problem in your Store.
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Work With Active Jobs (03/08/02)

The Work With Active Jobs screen displays all the jobs that are currently running:

current .
Opt Subsystem/Job User Date a Timea

Note: QBATCH capacity is 4 jobs that can run in parallel. AMSMON and DIMEMT are monitor jobs that should always be
running in theWork with Active Jobs screen.

The following table explains each section of the Work with Active Jobs screen:

Active Jobs Number of jobs that are currently running. It does not include user sessions.

Position to job Use this field to find a specific job, if there are many jobs on the screen. Type the first few letters of the
job name and press Enter.

Opt Type 2 to change the job priority or 4 to end the job immediately, for any of the jobs that are currently
running.

Subsystem/Job Jobs are grouped under a given subsystem name. These are headings used to group different types of
jobs. There are no actual subsystems.

Current User Name of the user who submitted the job.
Pty Job’s run priority.
Status/ETA Displays RUN until an Estimated Time of Arrival (ETA) has been calculated. The first time a job runs on

your system, it does not show an ETA for jobs that just started. On subsequent runs, the ETA is
calculated by taking an average of the last 5 times the job was run. No ETA is shown when the job takes
1 minute or less. Once the expected time of completion is known, this shows how much time remains for
the job to finish. For monitor jobs (e.g. AMSMON), it always displays RUN. If someone uses option 4 to
end a job, the status is END until the job no longer displays on the screen.

Began Date (MM/DD/YY) and time (HH:MM:SS) when the job started running.

[ ]
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2=Change

4=End

F3=Exit
F5=Refresh

F7=Find

F8=Repeat find

F10 = Service
Status

F12=Cancel

F16=Resequence

F17=Top

F18=Bottom

Dealer Development

. ®
m & Learning

Displays the Change Job screen where you can change the job priority. Changing it to a lower number
gives it more system resources (compared to other active jobs) so that it may finish a little sooner.

Allows you to end a job that is in progress. You can only use this for jobs that are not updating the
database. If you use this for a job that is updating the database, it will not end the job.

Returns to the menu.
Redisplays the contents of the screen to show the most current information.

Displays the Find a string window where you can search through one of the columns on the screen.
Note that the system places the cursor in the “Opt” column beside the matching job. For example,
if you wish to find a job on the screen, type a portion of the job name beside String and then type
*JOB beside Column.

Repeats the previous find operation.

Displays the Frontier Health Monitor screen where the statuses of all the supporting systems can be
monitored. Call RSSD if one of the lights is red.

Returns to the previous screen.
Allows you to choose which column to use to sort the jobs listed under each subsystem.

By default, the jobs are sorted by the job start date/time (from oldest to newest).

Place the cursor on that column and press F16, to sort the jobs using a different column. A blue arrow
V displays in that column to indicate that the jobs in each subsystem are now sorted by that column.

Place the cursor on that column and press F16 to change the sort order (from newest to oldest or
oldest to newest). The arrow changes direction A to indicate the change to the sort order.

Returns to the top of the list of jobs.

Returns to the bottom of the list of jobs.
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If you type 2 beside an active job, the Change Job screen displays where the only thing you can change is the job
priority (where 1 is highest priority and 9 is the lowest). If you had several jobs running at once and you need one
job to finish sooner,you can increase the priority of that job and/or decrease the priority of the others.

Change Job (CHGJOB)
Type options, press Enter.

Jobname . . . . . . . . . . . . > RPTDLYTYP Name,
.. e e e e e e e DEALER_1 Name
ID . . . .« & v « v 4 e . . . > 12870
Job priority (on JOBQ) . . . . . 9
Additional Parameters
Job queue . . . . . . . . . .. v
Schedule date (MMDDYY) . . . . . # S, *CURRENT,

ED, *THU,
R *FRI, , *SUN
schedule time (HHMMSS) . . . . . * Time, / *CURRENT

F3=Exit F12=Cancel
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Work With Job Queue (03/08/01)

A job queue is essentially a list of jobs waiting to run. The system comes with different job queues with different
purposes. Most job queues release one job at a time for processing where the next job in the queue does not start
until the previous one has ended. However, job queues QBATCH, AMS and CTCBATCH may release several jobs at a
time, depending on the current capacity of the processor. There is a specific menu option that you can use to
access the job queues that you use themost. To access any of the other job queues, you need to use the Work With
All Job Queues screen.

The following table identifies each job queue by menu option:

03/08/01 QBATCH Most jobs submitted for immediate processing go here.

03/08/03 LBATCH Certain reports such as the Tax Exempt Report (10/35) and manpowerscheduling
reports (19/08 and 19/09) and lengthy jobs such as ADDBINCAP (07/14/04) and
DELBINCAP (07/14/07) go here.

03/08/04 SBATCH Jobs that may not run at the same time go here (e.g. price changes).

03/08/06 CTCBATCH Jobs that must run in subsystem CTCBATCH go here (e.g. system management or
communication jobs).

03/08/08 NBATCH Jobs submitted to run at night go here. Jobs in this queue are not run until the job
queueis released (which is automatically done every night during Daily Sales
processing).

03/08/09 CBATCH Daily Sales Processing job (DLYSLSmmdd) goes here.

03/08/10 SATQUE Jobs submitted to run on Saturday night go here. Jobs in this queue are not run
until the job queue is released (which is automatically done every Saturday night
during Daily Sales processing).

03/08/11 SUNQUE Jobs submitted to run on Sunday night go here. Jobs in this queue are not run until
the job queue is released (which is automatically done every Sunday night during
Daily Sales processing).

03/08/12 RPTQUE Certain reports such as the period end report go here. Jobs in this queue are not
run until the job queue is released (which is automatically done every night during
Daily Sales processing).

The last two menu options do not display job queues but related information.

03/08/15 Screen lists all available job queues. Displays the number of jobs currently in the
queue. Allows you to display the jobs currently waiting in a queue.
03/08/32 Screen lists all the jobs that you submitted (and which have not yet started to run).

Note: In the Equity system, the equivalent screen also lists jobs that are in progress
as well as jobs that have ended.
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The same screen displays for each of these menu options but the name at the top left tells you which job queue you are
working with.

work with Job Queue

Queue: QBATCH Status: RLS
Position to job . . . . .
Type options, press Enter.

2=Change 4=End 6=Release

opt Job User ID Priority Status
RPTPRDPRF USERNAME 0000000000000071142 1 HLD

F3=Exit Fl2=CanceT

Jobs are grouped on the screen by status (RDY, then SCD, then HLD) and within each group they are sorted by
priorityand job name.
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The following table explains each section of the Work With Job Queue screen:

Queue Name of the job queue.

Status Status of the job queue may be RLS (released) or HLD (held). If the job queue is released, the jobs
in the queue will be run in the order in which they display in the queue. If the job queue is held,
none of the jobs will run. You can hold or release a job queue in menu option 03/08/15, Work
with all job queues.

Position to job Adjust the list to a specific job if there are many jobs in the queue. Type the first few characters
of the job name and press Enter. The jobs are now listed alphabetically by job name (no longer
grouped by status or priority), starting with the job that most closely matches what you typed. If
you typed a symbol (such as *) or a number, it starts with the first job since there are no jobs
that start with symbols or numbers.

Opt For any job listed in the queue, use option 2 to change the job (move it to a different queue or
enter/remove a schedule date/time) or use option 4 to end the job (so that it does not run) or
use option 6 to release the job if it is on hold.

Job Name of the job that helps you identify what the job does. In the example above, the job name is
RPTPRDPRF which stands for product performance report.

User Name of the user who submitted the job. If submitted by the system, the name is usually
QPGMR.
ID Job ID number. Every job that runs in the system has a unique number. You may have two jobs

with the same name, but the ID is always different.

Priority Indicates the order in which the jobs are run. You can change the priority to move a specific job
higher or lower in the queue. The highest priority is 1 and the lowest is 9.

Status Job status may be:
HLD — the job is on hold and must be released before it can run.
SBT — the job runs according to its position in the queue.

SCD — the job has a schedule date/time — only after the date/time is reached will it run according
to its sequence in the queue.

2=Change Make some changes (see below) while the job is in the queue and not yet running.

4=End End the job in the job queue (before it starts) if a job is submitted but you no longer want it to
run. A confirmation screen displays when you type a 4 beside a job on the screen. When you end
a job, a break message is sent to the workstation from which the job was submitted to notify the
user that the job was ended. It also sends a message to the QSYSOPR message queue (03/08/31)
that indicates that the job was ended along with the name of the user who ended it.

6=Release If the job is submitted on hold, it sits in the queue with a status of HLD until you either release
the job (option 6) or end the job (option 4).
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If you enter a 2 beside a job on the Work with Job Queue screen, the Change Job screen displays where you can
changethe job priority (in the queue), the job queue and the scheduled date/time.

Change Job (CHGJIOB)
Type options, press Enter.

Jobname . . . . . . . . . . . . > RPTDLYTYP Name, *
e e e e e e e DEALER_1 Name
ID . . . . . . . e e ... 12870
Job priority (on JOBQ) . . . . . 9 1-9, ¥*SAME
Additional Parameters

Job gqueue . . . . . . . . . . . Name, *SAME

schedule date (MMDDYY) . . . . . *SAM Date, *SAME, *CURRENT,
ONTHEND,
*WED, *THU,
*SUN

schedule time (HHMMSS) . . . . . *SAM T , *CURRENT

F3=Exit Fl2=Cancel

The following table explains each section of the Change Job screen:

Job Name The name of the job that helps you identify what the job does. In the example above, the job
name is RPTPRDPRF which stands for Product Performance report.

User The name of the user who submitted the job. If the job was submitted automatically by the
system, the name is QPGMR.

ID The job ID number. Every job that runs in the system has a unique number. You may have two
jobs with the same name, but the ID is always different.

Job Priority This indicates the order in which the jobs in the queue will run. You can change the priority to
move a specific job higher or lower in the queue. The highest priority is 1 and the lowest is 9.

Job Queue If you wish to move the job to another job queue, type the name of the queue and press Enter.

Schedule Date If the job has no schedule date, it runs in the sequence it appears in the queue. If the job has a
schedule date (MM/DD/YY), the system ignores the job until the schedule date/time has passed
and then it runs in the sequence in which it displays in the queue. If you wish to change the date
when a job is scheduled to run, type the date (YYMMDD) and press Enter.

Schedule Time If you wish to change the time when a job is scheduled to run, type the time (HHMMSS) and
press Enter.
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Work With All Job Queues (03/08/15)

The Work With All Job Queues screen (03/08/15) lists all the job queues in the system. From this screen, you can
workwith any of the job queues in your system.

Work with All Job Queues

Position to queue .
Type options, press Enter.
3=Hold 5=Work with 6=Release 14=Clear

Oopt Queue name Capacity Number of Jobs Status
AMS 10 RLS
AMSBATCH 1 RLS
CBATCH RLS
CTCBATCH RLS
CTCMQ RLS
DEFAULT RLS
LBATCH RLS
MONITORS RLS
MQQ RLS
MQTALKQ RLS
NBATCH HLD
QBATCH RLS
QCTL RLS
RPTQUE HLD

iy

-

S S SR Sy
O © O N O 0 0O 0O 000 0 =0 OC

F3=Exit F5=Refresh F12=Cancel F17=Top F18=Bottom

Note: The plus sign at the bottom right corner of the screen indicates there are more job queues that can display on
the screenat once.

) Dealer Devel
ATV &?.aeg:nin?eopment 76 | June 2021




FRONTIER COMPUTER OPERATOR REFERENCE GUIDE

The following explains each section of the Work With All Job Queues screen:

Position to Queue

Opt

Queue Name
Capacity
Number of Jobs

Status

3=Hold

5=Work with
6=Release

14=Clear

The job queues are listed alphabetically. To start the list with a specific queue, type the first few
letters (or just a single letter) and press Enter.

For any job queue listed, use option 3 to put the queue on hold, option 5 to display the Work with
Job Queue screen, option 6 to release the job queue (if it is on hold) and option 14 to clear the job
queue (i.e. end all the jobs in the queue).

Name of the job queue.
Indicates the maximum number of jobs that a job queue may release at once.
Total number of jobs currently waiting in the queue.

Job queue status may be RLS or HLD. If it is HLD, none of the jobs in the queue will run until the
queue is released. You can release a queue manually using option 6.

Some job queues (NBATCH, RPTQUE, SATQUE, SUNQUE, MQQ, MQTALKQ) are normally HLD
during the day and released automatically at night during Daily Sales processing. For these job
queues, the statusautomatically changes to HLD with the first job submitted to that queue
during the day.

Allows you to put the job queue on hold so that any jobs submitted to that queue will not run until
the queue is released.

Allows you to display the Work with Job Queue screen listing the jobs currently in the queue.
If the queue is on hold, it has a status of HLD until the queue is released.

Allows you to end ALL the jobs currently in the job queue. When you select this option, a
confirmation screen displays. If you press F12 to cancel, the previous screen displays, and no jobs
are ended. If you press Enter to confirm, all the jobs in the queue are ended.*

A break message is sent to the workstation from which the job was submitted to notify the user that
the job was ended. It also sends a message to the QSYSOPR message queue (03/08/31) that
indicates that the job was ended along with the name of the user who ended it.

* Two important jobs (APOSCALC and POSTORD) cannot be ended, even when in the job queue.
(APOSCALC is the job that calculates promo orders and POSTORD is the job that transmits your
orders to Home Office.)
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The following table explains each section of the Work With Submitted Jobs screen:

Submitted from

Opt

Job

User

Pty

Status

Schedule Date
Schedule Time

2=Change

4=End

6=Release

F3
F5

F11

F12
F17

F18

Dealer Development

. ®
m & Learning

Always displays *USER to let you know that these are the jobs that you submitted.
For any job listed, use option 2 to change the job (move it to a different queue or enter/remove a
schedule date/time) or use option 4 to end the job (so that it does not run) or use option 6 to

release the job (if it is on hold).

Name of the job that helps you identify what the job does. In the example above, the job name is
RPTPRDPRF which stands for Product Performance report.

Your Frontier Display name.

Indicates the order in which the jobs in the queue will run. You can change the priority to move a
specific job higher or lower in the queue. The highest priority is 1 and the lowest is 9.

Job status may be:
HLD —the job is on hold and must be released before it can run
SBT — the job will run according to its position in the queue

SCD - the job has a schedule date/time — only after that date/time has been reached will it run
according to its sequence in the queue

Jobs with a status of SCD, this shows the date when the job is scheduled to run (MM/DD/YY).
Jobs with a status of SCD, this shows the time when the job is scheduled to run (HH:MM:SS).

Make some changes (see Error! Reference source not found. Job on page 77), while the job is in
the queue and not yet running.

End a job in the job queue (before it starts) if a job is submitted but you no longer want it to run.
The following screen displays when you type a 4 beside a job on the screen.

If the job was submitted on hold, it sits in the queue with a status of HLD until you either release the
job (option 6) or end the job (option 4).

Returns to the menu.

Refreshes the information on the screen.

Toggles the display between *USER and *JOB. When showing the jobs submitted by the current user
(*USER), it shows all the jobs that you submitted, even in other sessions. When showing the jobs
submitted by the current job (*JOB), it shows all the jobs that you submitted in the current session.
Returns to the previous screen.

Returns to the top of the list.

Takes you to the bottom of the list.
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Work With Workstations (59/05)

The Work With Workstations screen (59/05) shows you the user currently signed on to your system (along with
theworkstation name) and, also shows you all workstation names that have ever been used to sign on to your
system.

To see who is signed on right now, click the “Signed On” column heading twice. This sorts the list so that all
workstations with a Y under “Signed On” appear at the top of the list.

Note: If the workstation is signed on but the user name is blank, it means the workstation is an EFD (employee
facing device).

Work with workstations

Show 10 v entries Search
Workstation Name Signed On First Used Last Signed On User Name
DSPO1 Y 2018-12-13 14:56:07 2018-12-13 16:22:36 DEALER_1
QPADEV1091 N 2018-12-13 13:31:32 2018-12-13 13:32:32
QPADEV1218 N 2018-12-13 10:40:50 2018-12-13 11:19:51
QPADEV1703 N 2018-12-13 11:20:08 2018-12-13 12:01:50
QPADEV1962 N 2018-12-13 11:36:09 2018-12-13 13:30:34
QPADEV2301 N 2018-12-13 14:58:38 2018-12-13 14:58:50
QPADEV4883 N 2018-12-13 12:01:59 2018-12-13 12:57:21
QPADEV6090 Y 2018-12-13 12:57:32 2018-12-13 12:57:58 DEALER_QC
QPADEV7608 N 2018-12-13 11:27:14 2018-12-13 13:55:48
QPADEV7922 N 2018-12-13 09:56:43 2018-12-13 10:40:39

Showing 1 to 10 of 12 entries Previois - 2 | Next
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Security and User Maintenance

This section outlines the steps to use common features of Security and User Maintenance in Frontier. Only ADMIN
users have access to this.

Follow these instructions to set up the user profile once the user is created in CTID:

From the Frontier Master Menu:

» Type menu options 59/07/01.
» Press the Enter key after typing each option.

The Work with User Profiles screen displays:

Work with User Profiles

Opt AD Signon Display Name Menu/Option

» Type 2 in the Opt field beside the user you want to set up a profile for.
» Press the Enter key.

Note: New user names display after the user is created in CT ID after approximately 30 seconds. If an Active Directory
(AD) account has not been used in over a year, the highlighted user is not able to sign on. The AD account must be
reactivated before it can be used. If it will not be used again, the account should be deleted.

_les.testshnred TESTUSER DF
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The Set Up User Profile screen displays:

Set up User Profile

» Type a User Name in the Frontier display name field.
Note: This is not the User Name the user uses to sign on to Frontier. This is the name that displays on Frontier screens
and reports.

» Press the Tab key.

» Type Ein the Language field for the English version of Frontier.

OR
» Type Finthe Language field for the French version of Frontier.

» Press the Tab key.

» Type Y inthe Hide cost on Floor Inquiry field to display product cost when pressing F15 on the Product
Inquiryscreen.

» Type N in the Hide cost on Floor Inquiry field to hide the product cost when pressing F15 on the Product

Inquiryscreen.
» Press the Tab key.

» Type Y in the Display date after signing on field to display the Inventory Date screen when the user signs on.

» Type N in the Display date after signing on field to display the initial menu when the user signs on.
» Press the Tab key.

» TypeYin the Secure output field to produce certain reports on the Work with Secure Print output screen.

» Type N in the Secure output field to produce all reports on the Work with Print Output screen.
» Press the Tab key.
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Note: Refer to the Work with Print Output and Work with Secure Print Output sections for instructions to display the
screens. The Work with Secure Print Output screen only appears for users where you entered a Y in the Secure output field.

» TypeY in the WISFIL upload administrator field to display WISFIL in the File Upload window.

OR
» Type N in the WISFIL upload administrator field to hide WISFIL in the File Upload window.

Note: WISFIL is only used during a Dealer changeover by the person who uploads the file with the full inventory count.
The name of the file is WISFIL (after a third-party inventory company Western Inventory Services). However, the same
file is used even if thethird-party company performing the count is Retail Grocery Inventory Specialist (RGIS). The default
should remain N unless Store is going through a changeover and needs to upload the WISFIL.

» Press the Enter key.

After creating and setting up a new user profile, you must set the initial menu and specify the menu options the
usercan access. There are three ways to set up menu permissions:

» F8:Load a user template. Refer to the Loading a User Template section for more information.
» F6: WW User Permissions (Authorizing Individual Menu Options). Refer to the Authorizing Individual Menu

Options section for more information.
» F10: Copy user profile. Refer to the Copying an Existing User’s Permissions section for more information.

Follow these instructions to add a set of menu permissions for a user by loading a user template:

From the Set up User Profile screen:
» Press the F8 key.

The Select User Template pop-up displays:

Set up User Profile

Select User Template

opt User Template Description
ADMIN A rator

» Type 1inthe Opt field beside the appropriate template.
» Press the Enter key.
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Note: Refer to the Default User Templates section for more information on what templates access which
menus/options.

The Load User Template pop-up displays:

Set up User Profile
TYFE

AD Signon .

Load User Template

*ADMIN

|
|
|
|
|
|
|
|
|
|
|
|
|
|
L

xit F6=WW U ions oad user template F1@=Copy use

F13=Reins

» Press the Enter key.
The menu options of the template are loaded into the list of authorized menu options for the user.

» Repeat steps 1 to 4 if you want to load options from additional templates. Additional templates cannot be
loaded for users where you loaded a TASK or RF template

Note: If you load the TASKRET or TASKINQ templates, you cannot load additional templates. If you load these templates
but wantthe user to access other menu options, you must delete the user profile and start over.
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Follow these steps to add menu permissions for a user by selecting menus and menu options individually:

From the Set up User Profile screen:
» Press the F6 key.

The Work with User Permissions screen displays:

{ with User Permissions

Menu . L Parent Menu
Opt C:gde,u"Dphgn Menu Description Code/Option
*-partial permission

» Press the F6 key.

The Menu Permissions screen displays:

Menu Permissions

*-Partial permission Initial menu code

S MENU

G MENU

n parameter
ork o

ntory au

option

issing permissi

to grant permission. Remove 'X' to revoke permission.

Note: The contents of this screen display all possible options for the Master Menu.

» Type X beside each menu option that you want the user to access.

» Press the Enter key.
» Press the F12 key several times.
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The Confirm Permissions pop-up displays:

Menu Permissions
*-Partial permission Initial menu c
MASTER MENU
01 Sales manager menu X 22 STOR
03 Computer o 3 MERC
04 Ordering m |

Confirm Permissions

entory Menu

ncy functions menu
uling menu
unting menu
MENU

option

F3=Exit sing permissic 8=Set initial

' to grant permission Remove ‘X' to revoke permission

*

Type Y in the Confirm menu permissions field.
Press the Enter key.

The Work with User Permissions screen displays with the authorized menu options:

Work with User Permissions

on : ADAM Initial menu cod
Name : ADAM

Type options, Enter. 4=Remove

Menu Parent Menu
Opt Code/Option Menu Description Code/Option

*-Partial permission

EQ o1 Sales manager menu

EQ o7 Product inventory menu
EQ 10 Reports menu

EQ 22 STORE ANALYSIS MENU

F3=Exit F6=Menu permissions F12=Previous

Review the menu options to ensure you have provided all the permissions required for the user.
Type 4 in the Opt field to remove access from any menu option.
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Note: If there are conflicts, an error message displays at the bottom of the screen. Refer to the Possible Error
Messages sectionfor more information on resolving issues.

If you allow access to a menu option that displays a sub-menu, it automatically assigns access to all options
in the sub-menu. If you want to restrict access to a certain sub-menu within a parent menu option, you
need to do this manually.

From the Menu Permissions screen:
Type the number in the Enter option field of the menu you want to expand.
Press the Enter key.

The sub-menu displays:

Menu
Type options, press Enter. X=Allow
*-Partial permission Initial menu code/option:
SALES MANAGERS MENU
01 Inventory manager's inquiry
02 Floor inquiry
03 Sales so far today
10 Ordering menu
20 Work with management reports

> > > > > >

30 Send messages to people

MENU: EC Enter option: - Display name: ADAM
F3=Exit F6=Unlinked menus F7=Show missing permissions F8=Set initial
F9=Select/deselect all F12=Previous

Use 'X' to grant permission. Remove 'X' to revoke permission.

1t

Type X beside each sub-menu option that you want to grant user access.

OR
Press the Space bar key and then press the Enter key to delete the X beside any option you do not want the
user to have access to.
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Note: For any sub-menu with only specific options granted access, a yellow asterisk displays beside the appropriate
optionnumber on the parent menu. This indicates the user does not have access to all options in the menu.

Menu Permissions
Type options press Enter (=Allow Acces
*-Partial permission Initial menu code/option: EQ
M ENU
X 1 Sales manager menu 22 STORE ANALYSIS MENU
Computer operator menu 23 MERCHANDISING MENU
Ordering menu 25 APAP menu

Shipping and receiving 26 AIM menu

An existing user’s permissions can be copied when setting up a new user. This can be done at any time, even
for a user profile that is already set up and has existing permissions. When copying an existing user, it replaces
ALL permissions for the existing user with those from the selected user. Follow these instructions to add menu
permissions for a user bycopying them from an existing user:

From the Set up User Profile screen:
Set up User Profile

AD Signon 9.jeantremblay

r display name

F3=Exit F6=WW User Pe oad user template

F12=Cancel F13=Reinstate popup

» Press the F10 key.
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The Select User Profile pop-up displays with a list of all existing user profiles:

Set up User Profile

1=Select
Hide yst on Initial
Display date AD Signon Display Name Menu/Option
Initial menu 0949 .laurareynhoudt LAURA EQ
Secure outpu 8949 haelkirkpa MIKEK EQ
WISFIL uploa 0949. MIKEA EQ
0949 . mikesteger MIKES EQ
2949 _paulwrightson PAUL EQ
0949 .qsecofr QSECOFR EQ
0949 .returns RETURN EC
0949 .rf

F12=Previous

Permi ons F8

F12=Cancel F13=Reinstate popup help

Type 1 in the Opt field beside the user profile to copy.
Press the Enter key.

The Copy User Profile pop-up displays:

Set up User Profile S > #: 949

H -

Select User Profile ‘

|
| \
AD Signon . | Position to __
Frontier dis ‘
Language | ‘
Hide cost on | Copy User Profile
Display date
Initial menu ‘ from @949.laurareynh ‘
Secure outpu | ® ‘
WISFIL uploa | Existing permissions will be replaced
| \
| \
| \
| \
| \
| \
| \
| \
L

F12=Previous

e

F12=Previous

R EEEEECECCEm————————..

F3=Exit F6=WW User Permissions F8=Load user template F10=Copy user profile
F12=Cancel F13=Reinstate popup help

Type Y in the Copy from field.
Press the Enter key.

The Select User Profile screen displays, and the existing user’s permissions are copied for the new user.
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This table outlines possible errors messages and how to resolve them:

Possible Error
Messages

Invalid initial menu for the permissions. Displays if you type X beside options that do not have a parent

Press F7 to showmissing permissions. menu in common or are not compatible with the current initial

Tope options, press o Access menu (shown at the top right corner of thescreen). To resolve
MASTER MENU the err‘or:

» Press the F7 key.

» The input field beside the menu options that
require an X are highlighted.

Permission allowed for an unlinked Displays if you type X beside one or more options in the Master
menu OR options inthe hierarchy, not Menu hierarchy and, also beside one or more options in an
both. unlinked menu. This message displays if youtype X beside one

or more options in an unlinked menu and you try to load
additional permissions from a user template. To resolve the
error:

» Press the F12 key to exit the Load User Template
window.

» Press the F12 key again to exit the Select User
Template window.

» Press F6 to display the Menu Permissions screenif you
do not want the user to have access to an unlinked
menu.

» Remove the X from the options.
» Press the Enter key.

» Press the F6 key to display the Menu Permissionsscreen
with the Master Menu options.

» Select the options in the Master Menu.
OR
» Go back to the Set up User Profile screen andpress
the F8 key to load a template.

A user may have access to the Master Menu or to an unlinked
menu, but not both. To set up a user to view anunlinked menu
after signing on and be able to access options from the Master
Menu, create custom options inthe unlinked menu that copy
options from the Master

Menu.
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Possible Error
Messages

Can only give permission to a single Displays if you type an X beside one or more options in two or more

unlinked menu. unlinked menus. You can only set a user upwith access to a single
unlinked menu. You need to remove each X that you typed on one of
the unlinked menus.

Missing permissions to access sub- Displays if you:
menu. Press F7 toshow missing
permissions. » Navigate to a sub-menu.

» Type X beside one or more options.
» Press the F12 key to return to the previous menu.

AND

» Press the F12 key again without typing X besidethe option
that accesses the sub-menu.

Deleting a User

This section outlines the steps to delete a user profile from Frontier. You may wish to delete a user for the
followingreasons:

» The user is no longer with the company (i.e. resigned, terminated, or laid off).
» An unchangeable mistake such as a username error or a TASK template loaded for a user that requires

additional options.

Note: Deleting the user profile in Frontier does not delete it in CT ID. You need to remove the user from CT ID
separately.

From the Master Menu:

» Type menu options 59/07/01.
» Press the Enter key after typing each option.

« ® Dealer Devel CANADIAN TIRE
SOV e Teaming T 90 |June 2021 UNIVERSITY



FRONTIER COMPUTER OPERATOR REFERENCE GUIDE

The Work with User Profiles screen displays:

» Type 4in the Opt field beside the User profile you want to delete.
» Press the Enter key.

The Delete User Profile screen displays:

Delete User Profile

F3=Exit Fl2=Cancel

Press Enter to confirm your choice for 4=Delete user profile

» Press the Enter key.

The Work with User Profiles screen displays, and the User profile is deleted from the Frontier system.
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Displaying Permissions
You can review the menu permissions for different user profiles in your Store. You can display and print all the

permissions given to a specific user, display and print all users with permissions to specific menus or print all
permissions.

Note: All reports are created immediately. You can also display the report on the Work with Print Output screen.
Refer to theWorking with Print Output screen section for more information.

Follow these steps to display and print permissions for a specific user.

From the Master Menu:

» Type menu options 59/07/02.
» Press the Enter key after typing each option.

The Display User Permissions screen displays:

Display User Permissions

User Profile
Frontier Initial
Opt AD Signon Display Name Menu/Option
PAULS EQ
PHIL EQ
PRATIQUE EQ
EQ
EQ
EQ
QS YS EQ
RACHELLE EQ
XX
06
EQ

EQ

F14=Print all

» Type 5inthe Opt field beside the user whose permissions you want to display.
» Press the Enter key.
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The View User Permissions screen displays with a list of authorized menus and submenu options for the user:

View User Permissions

AD Si
Displ

Menu Parent Henu
Code/Option Menu Description Code/Option
#-Partial permission

F3=Exit F12=Previous Fl4=Print
No data to display.

e1/e1

» Press the F14 key to print the list.

The Permission Report (by user) prints:

Store &: 870 Permission Report (by user) USERNAME MM,DD/YY HH:MM:55 Page: 1
. Frontier Meru . o Farent .
AD Sighon Display Name Code,/Opticn Meru Description Meru Code/Option
* - Partial permission
John. Smith JOHN EQ 05 Shipping and receiwing meru
EQ 05 Claims _and settlements meru
EQ 15 Radio freguency functions meru

#* and of report =

Follow these steps to display and print permissions for a specific menu:

From the Master Menu:

» Type menu options 59/07/02.
» Press the Enter key after typing each option.
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The Display User Permissions screen displays:

Display User Permissions

2y

User Profile

Frontier Initial
Opt AD Signon Display Name Menu/Option

PAULS EQ
PHIL EQ
PRATIQUE EQ
PRO EQ
PROMO EQ
QSECOFR EQ
QSYSOPR EQ
RACHELLE EQ
RECEIVE XX
RETURNS 06
RICK EQ
SARA EQ

F3=Exit F11=Search by menu F12=Previous F14=Print all

Press the F11 key.

The View Menu Permissions screen displays:

View Menu Permissions

Frontier
AD Signon Display Name Permissions
#-Partial permission

F3=Exit Fl2=Previous Fl4=Print

Type the code of the desired menu or menu option in the Menu Code (?)/Option field.
Press the Enter key.

Example: If you want to see which users have access to any or all options in the Product Inventory Menu use
code EE.

Note: If you do not know the menu code, type a ?. The Select Menu Code window displays where you can select the
appropriatemenu code from a list.
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The list of all users with permission to access the specified menu or menu options displays:

» Press the F14 key to print the list.

The Permission Report (by menu) prints:

Store &: 370 Permission Report (by meruil USERNAME MM/DD /Y HH:MM:S5 Page:
Meru Code/Option . . EE PRODUCT INVENTORY MENL
. Frontier Lo
AD Signon D'l@'lav Name FPermissions
*-Fartial permission
John. Smith JOHN All
Mary.Young MARY A1l
=% gnd of report ==

1

Follow these steps to print a list of all permissions.

From the Master Menu:

» Type menu options 59/07/02.
» Press the Enter key after typing each option.
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The Display User Permissions screen displays:

Display User Permissions

User Profile
Frontier Initial
Opt AD Signon Display Name Menu/Option
PAULS EQ
PHIL EQ
TIQUE EQ
EQ
EQ
EQ
EQ

CHELLE EQ

RECEIVE XX
RETURNS 06
RICK £Q
SARA EQ

y menu F12=Previous F14=Print all

» Press the F14 key.

The Permission Report (by menu) prints:

Store &: 370 Permission Report (all users) DEALER_1 1/02/18 11:44:47 Page: 1
Frontier Meru Farent
AD Signon Display Name Code Option Meru Description Meru Code/Opticn
% - Partial permission
ANDREW EC 01 Sales manager meru
EQ 02
EQ 07 Product imventory meru
EQ 10 Reports meru
EQ 22 STORE ANALYSIS MENU
EQ 23 MERCHANDISING MENU
EC 26 AIM menu
EQ 20 Signage meru
BETTY EQ hil Sales manager meru
EQ 03 = Computer operator meru
oo 4 Comunications meru EQ 03
EQ 0e Customer returns meru
EQ 05 Claims and settlements meru
EQ 10 Reports meru
EQ 22 STORE ANALYSIS MENU
EQ 23 MERCHANDISING MENU
EG 30 Signage meru
FI 20 work with Froactive Dashboard
EOE EC 01 Sales manager meru
EQ 03 Computer operator meru
EQ 05 Shipping and receiving meru
EQ 08 Claims and settlements meru
EQG 10 Reports meru
EQ 15 Radio frequency functions meru
EQ 23 MERCHANDISING MENU
EQ 20 Sigrage meru
PI 05 Location History
FI 20 work with Froactive Dashboard
Pl 02 Maintain Proactive Product Class
Pl 03 Maintain Proactive Triggers
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Working With User Templates

A user template is a package of menu option permissions. It is a pre-defined set of authorized menu options
that maybe granted to a user in a single step.

Frontier comes with many default user templates that work for most users in your Store. All default template

namesstart with an asterisk. New user templates can be created by copying an existing template or by creating
one from scratch.

A user template can be set up by copying an existing template. You can still make changes by adding or
removingpermissions. Follow these steps to create a new user template by copying an existing template:

From the Master Menu:

» Type menu options 59/07/05.
» Press the Enter key after typing each option.

The Work with User Templates screen displays:

Opt User Template Description

» Type 3 in the Opt field beside the User template you want to copy.
» Press the Enter key.

. Dealer Development CANADIAN TIRE
m & Learning 97 | June 2021 v B ;wﬂﬁﬁgj}gaa Y

L® A (1=



FRONTIER COMPUTER OPERATOR REFERENCE GUIDE

The Copy User Template pop-up displays:

Work with User Templates

Opt User Templat Copy User Template

*ADMIN

» Type a template name in the New user template field.

» Type a short template description in the Description field (optional).
» Press the Enter key.

The new template displays in the list.

» Type 8 in the Opt field beside the new template.
» Press the Enter key.

The Work with User Template Permissions screen displays with a list of authorized menu options.

» Type 4 to remove menu options.
OR
» Refer to the Authorize Individual Menu Options section for more information on adding options to the list.

If there is no default or custom template that suits the needs of the user, you can create a template from scratch.
Follow these steps to create a template from scratch.

From the Master Menu:

» Type menu options 59/07/05.
» Press the Enter key after typing each option.
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The Work with User Templates screen displays:

Work with User Templates

pt

Opt User Template Description
IN

» Press the F6 key.

The New User Template pop-up displays:

Work with User Templates

New User Template

» Type a name for the template in the User template field.

» Type a short template description in the Description field (optional).
» Press the Enter key.

The new template displays in the list.

» Type 8 in the Opt field beside the new template.
» Press the Enter key.

The Work with User Template Permissions screen displays with no existing permissions in the list.

» Refer to Authorizing Individual Menu Options for more information on adding individual menu options.
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Any custom template descriptions and permissions can be changed but a default template (marked with an
asterisk)cannot. When you change a template, the changes are immediately in effect.

Note: To change a template name, create a new template with the new name you want by copying it and deleting the
oldtemplate.

Follow these steps to change a template description:

From the Master Menu:

» Type menu options 59/07/05.
» Press the Enter key after typing each option.

The Work with User Templates screen displays:

Work with User Templates

Opt User Template Description

» Type 2 in the Opt field beside the template you want to change.
» Press the Enter key.

The Change User Template pop-up displays:

» Type the new description (over the old one) in the Description field.
» Press the Enter key.

The new description is now in effect.
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Follow these instructions to change the template permissions:

From the Master Menu:

» Type menu options 59/07/05.
» Press the Enter key after typing each option.

The Work with User Templates screen displays:

» Type 8 in the Opt field beside the template you want to change.
» Press the Enter key.

The Work with User Template Permissions screen displays with a list of current permissions.
» Refer to the Authorizing Individual Menu Options section for more information.

Note: The Authorizing Individual Menu Options instructions refer to the Work with User Permissions screen but when
workingwith template permissions, the screen that displays is the Work with User Template Permissions.
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Any custom templates can be deleted but a default template (marked with an asterisk) cannot. When a

template

loaded into a user profile is deleted, the deletion has no effect on the user’s permissions. Follow these steps

to delete auser template.

Note: The template is simply a package that you can apply to a user.

From the Master Menu:

» Type menu options 59/07/05.
» Press the Enter key after typing each option.

The Work with User Templates screen displays:

Opt User Template Description

» Type 4in the Opt field beside the template you want to delete.

» Press the Enter key.

The Delete User Template pop-up displays:

» TypeYinthe Delete user template X (where X is the name of the template) field.

» Press the Enter key.

The window closes and the template is removed from the list.
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The following chart lists the default user templates that are built into Frontier, the level of access they have and
examples of user roles in Stores that may use these templates.

ADMIN When the user signs on, the Master Menu displays with access to » Dealer
ALLmenu options. Access to some of these options is controlled by

» Computer Operator
an employee PIN.

AlM When the user signs on, the Automated In-store Deal Management » Inventory Manager
Menu (AIM) displays. This template includes authorization to access
ALLoptions in this menu.

TASKRET When the user signs on, the Floor Inquiry screen displays. From

. . . » Customer Service Desk
this screen, the user can press any of the function keys displayed

at the bottom of the screen. The user can also press the ESC key Employees
to display apop-up menu with the following options:
01 Floor
inquiry 02 Add
rain checks
03 Clock in and out
04 Work with customer returns
05 Reprint customer returns
vouchers06 Work with signage by
product
07 RF Signage request
TASKINQ When the user signs on, the Floor Inquiry screen displays. From » General Floor Employees

this screen, the user can press any of the function keys displayed
at the bottom of the screen. The user can also press the ESC key
to display apop-up menu with the following options:

» Anybody using the
genericlnquiry screen

01 Floor

inquiry 02 Add

rain checks

03 Clock in and out

04 Work with signage by

product05 RF Signage

request

Access to some of these options is controlled by an employee PIN.
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INQUIRY When the user signs on, the Floor Inquiry screen displays. From this » General Floor Employees
screen, the user can press any of the function keys displayed on the
screen.

Access to some of these functions is controlled by an employee PIN.

This template only gives access to the Inquiry Screen without the
option to access the Task menu.

ORDER When the user signs on, the Master Menu displays with the following » Inventory Manager
options: » Third Party Ordering
01 Sales manager menu Service

01/01 Inventory manager’s inquiry
01/02 Floor inquiry
01/03 Sales so far today

03 Computer operator menu

03/02 Date control menu

03/02/03 Maintain current date

03/04 Communications menu

03/04/25 Ww orders communicated by MQ
03/08 Operating system commands menu
03/08/02 Work with active jobs

03/08/08 Work with nightly job g. “NBATCH”
03/08/10 Work with Saturday night job queue
03/08/11 Work with Sunday night job queue
03/08/31 Display QSYSOPR messages
03/08/33 Work with all printers

04 Ordering menu

04/01 Calculate suggested reg. orders
04/02 Work with orders

04/03 Post orders to communications file
04/06 Work with deals

04/07 Work with automated promo updates
04/08 Promo stock level menu

04/08/01 Calc. promo order by cutoff
04/08/02 Work with orders by date run
04/08/10 Change promo SL parameters
04/08/12 Work with promo stock levels
04/08/30 Ww promo Analyze exclusion crit.
04/08/31 Ww promo automatic posting crit.
04/08/32 Ww promo stock level defaulting
04/08/33 Ww B2B promo SL multipliers
04/10 Ordering parameters menu (ALL)

07 Product inventory menu

07/01 Work with corp. product info.

07/02 Work with Store product info.

07/09 Set prim. supply fac. for products
07/12 Work with order hold codes

07/34 Work with comments by prod. Group
07/35 Work with prepacks
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10 Reports menu

10/01 Work with management reports
10/04 Work with reporting options
10/23 Print ordering parameter analysis

22 Store Analysis menu (ALL)

POWERUSER When the user signs on, the Master Menu displays with access to ALL » Store Managers
menu options except 59 (Security Menu). » Department Managers
RECEIVING When the user signs on, the Master Menu displays with the following » Receiving Manager
options: » Adjusting/Shipping/Recei
05 Shipping and receiving menu (ALL) ving Employees
09 Claims and settlements menu (ALL)
15 Radio frequency functions menu (ALL)
This template includes authorization to access all options in these
menus. Access to some of these options may be controlled by an
employee PIN.
RETURNS When the user signs on, the Master Menu displays with the following » Customer Service Desk
options: Employees
06 Customer returns menu
09 Claims and settlements menu
This template includes authorization to access all options in these
menus. Access to some of these options may be controlled by an
employee PIN.
RF When the user signs on, the RF Terminal Options menu displays with the » General Floor Employees
following options: » Filling Crew

01 Inquiry

02 Inventory Audit

03 Fill / empty bin

04 File maintenance

05 Display check digit

06 RF Receiving

07 Manual receipt

08 Fill / from warehouse

09 RF Signage request

10 RF Fast Find Menu

11 Access Logistics RF Menu
12 RF receiving (full screen)
13 Express

14 Manage Containers

15 RF ERI

Access to some of these options is controlled by an employee PIN.
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SIGNAGE When the user signs on, the Signage menu displays. This template » Promo Employees
includes authorization to access all options in this menu.

Access to some of these options is controlled by an employee PIN.

TIRE
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Late Deal Claim

This section outlines the steps to complete a Late Deal Claim. With the Equity system, the Late Deal Claim tool was
an external app that you had to purchase and install.

Frontier includes a program that automatically calculates the credit amount that you can claim for late arrival of
dealmerchandise. All you need to do is enter the invoice number and truck arrival date. The program automatically
lists items eligible for a Late Deal Claim based on the criteria specified in the Returns and Warranty manual.

The program checks that the product is:

» Ordered in the on-time window.
» Notin product class 01-08 (tires are not eligible).
» Received on a truck that arrived on or after the deal start date.

For eligible products, the system generates a report that lists the products along with the claim
amount.The calculation is (Invoice Cost x (Invoice Quantity - Shortage Claims)) x .10.

Note: Late Deal claims program cannot be used for orders submitted in a prior year or for orders submitted more than
180 (even when claims are eligible).

Completing a Late Deal Claim

To complete a Late Deal Claim, you must do the following:

» Print the Late Deal Claim Delivery Form.
» Attach it and a copy of the invoice to a completed Adjusta-Card.

» Send the Claim for processing.

Note: To access this menu, users must have the required level of permission set up in the 59 Security Menu.

Follow these steps to complete a Late Deal Claim.

Note: Before you begin, you must post the invoice with the late shipment (menu options 05/01/0Opt. 10) and process the
DealerClaims for that shipment (menu options 15/11/0pt. 2).

From the Master Menu:

» Type menu options 15/21 or 09/21. Both paths navigate you to the Late Deal Claims Menu.
» Press the Enter key after typing each option.
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The Late Deal Claims screen displays:

» Type the invoice number in the Enter invoice# field for the invoice that includes the deal items that were
late.

» Press the Enter key.

» Type the arrival date in the Enter arrival date field which is the date the truck arrived.
» Press the Enter key.
» Press the F10 key.

The system checks the deal file and invoices and identifies the items that were received late, calculates the
totals and creates a PDF of the Late Deal Claim Delivery Form.

If there are products in the invoice that are eligible for a Late Deal Claim:

» Aprintjob called DGSLDRRPT submits.
» The job to print the report has been submitted message displays at the bottom of the screen.

If there are no products in the invoice that are eligible for a Late Deal Claim:

» A window displays indicating no records were found.
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Press the F10 key from any menu to display the Store reports.

The Work with Print Output screen displays in a new browser tab:

Work with Print Output show[25 v]entres  (7)

Report Name l Report ID l User Name l Job IAH printers + @show hide l yyyy-mm-dd .yn\rmm—au [ Filter -
(m] Report Name Report ID User Name Job AutoP [ Printer Pages Size (MB) Date Link

O  Shipment Contents EQZQPFR SHAWN Yes PRINTER1 1 0.04 2021-05-31 12:40:24 o) a im]

O Late Deal Delivery Claim Form LateDealDeliveryClaim TRACY DGSLDRRPT Yes PRINTER1 1 0.04 2021-05-31 12:31:46 = a ‘ﬁj

Form
o Dealer Claims Sent to Home Office ICDPRTO1 TRACY :/FALKiDCLAIMSTOOOO Yes PRINTER1 1 004 2021-05-31 12:30:36 = a (ﬂ
O  Summary Exception Report EXCPTSUM TRACY EXCPTSUM Yes PRINTER1 1 0.04 2021-05-31 12:24:40 faee] a ‘g

» Find the file named Late Deal Claims.
» Click on the icon of the format (PDF, TXT or CSV) you want to download.

The Late Deal Delivery Claim Form displays:

Late Deal Claim Delivery Form
Réclamations — retard de livraison
store/Magasin: 999 MM-DD-YYY
Invoice Product  Purchase Order Deal Deal Invoice Claim Product  Extended Cost
Number Mumber Mumber | Quantity - Number  Year Quantity Quantity {ost
Numéro  Numéro  Bon de commande  Muméro  Année Quantité Quantité Colt  cColt étendu
facture article MNuméro | Quantite  achat achat Tacture reclamat. article
1438376 350214 40750 1 322 2016 1 1 $53.84 153.84
1438376 406928 40834 1 323 2016 1 1 $53.36 £53.36
1438376 350214 40264 1 315 2016 1 1 $53.36 £53.36
1438376 423267 40945 4 325 2016 4 4 $7.79 £31.16
Total: §191.72
Claim/Réclamation: £19.17

Note: The report is bilingual for French users.
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